Network Reporting Terminal

INSTALLATION, OPERATION, AND
PROGRAMMING MANUAL

NOTIFI•FIRE•NET™ is a trademark of NOTIFIER, 1994.
# Table of Contents

## CHAPTER ONE  INSTALLATION ....................................................................................... 5

### Section One  NRT Mounting and Connections ........................................................................................................ 6
- 1.1 RELATED DOCUMENTATION ............................................................................................................. 6
- 1.2 NRT-NET INTERFACE CARD ............................................................................................................. 7
- 1.3 NRT EQUIPMENT ................................................................................................................................. 7
- 1.4 PRIMARY AND SECONDARY POWER .................................................................................................. 7
- 1.5 CONNECTING THE NRT-586T ......................................................................................................... 8
- 1.6 MONITOR INSTALLATION .................................................................................................................. 10
- 1.7 NRT UPS SUPERVISION .................................................................................................................. 12
- 1.8 STRAIN RELIEF ................................................................................................................................. 14

### Section Two  Peripherals ................................................................................................................. 15
- 2.1 CONNECTING A PRINTER .................................................................................................................. 15

### Section Three  Software ................................................................................................................... 16
- 3.1 INSTALLING THE NRT DATABASE SYSTEM ..................................................................................... 16
- 3.2 INSTALLING THE NRT SOFTWARE .................................................................................................. 17
- 3.3 INSTALLING THE LANDesk CLIENT SERVER ................................................................................ 17
- 3.4 INSTALLED PRINTERS ....................................................................................................................... 17
- 3.5 INSTALLED LIGHT PEN (LP-2) ........................................................................................................ 18
- 3.6 MAGNETIC TAPE BACKUP .............................................................................................................. 18

## CHAPTER TWO  PROGRAMMING ....................................................................................... 19

### Section One  Networking the NRT ........................................................................................................... 20

### Section Two  User Interface ............................................................................................................... 21
- 2.1 THE SCREEN ......................................................................................................................................... 21
- 2.2 USING THE MOUSE AND KEYBOARD ............................................................................................ 22

### Section Three  The Start-up Window ................................................................................................. 23
- 3.1 FILE MENU ......................................................................................................................................... 23
- 3.2 ADMINISTRATIVE MENU ................................................................................................................ 26
- 3.3 THE ACTION MENU .......................................................................................................................... 28
- 3.4 THE WINDOW MENU ....................................................................................................................... 29
- 3.5 THE HELP MENU .................................................................................................................................. 29

### Section Four  The System Interface Window .................................................................................... 30
- 4.1 THE SELECT SYSTEM DIALOG BOX ............................................................................................... 31
- 4.2 NODE DIALOG BOXES ...................................................................................................................... 34

### Section Five  The Active/Stored History Window .......................................................................... 42
- 5.1 CHANGING THE ACTIVE HISTORY BUFFER ................................................................................. 43
- 5.2 CHANGING THE STORED HISTORY FILE ..................................................................................... 43
- 5.3 PRINTING THE ACTIVE/STORED HISTORY WINDOW ..................................................................... 43
- 5.4 THE GRAPHIC HISTORY WINDOW ................................................................................................ 45

### Section Six  The Memo Window ........................................................................................................ 46

### Section Seven  The Upload/Download Window ............................................................................ 47
- 7.1 UPLOAD ................................................................................................................................................. 48
- 7.2 SCHEDULE UPLOAD ........................................................................................................................ 48
- 7.3 DOWNLOAD ......................................................................................................................................... 49
- 7.4 ABORT .................................................................................................................................................. 49

### Section Eight  The Graphic Presentation Window ............................................................................ 50
- 8.1 APPLYING ATTRIBUTES TO A CAD FILE ..................................................................................... 50
- 8.1.1 THE AFP-300/AFP-400 ............................................................................................................. 50
- 8.2 PROGRAMMING THE NRT ............................................................................................................... 51
CHAPTER THREE  OPERATION ............................................................... 57

Section One  Normal Operation ................................................................. 58

Section Two  Fire Alarms ........................................................................... 59
  2.1  FIRE ALARMS ................................................................................. 59
  2.2  ACKNOWLEDGING ONE OR MORE FIRE ALARMS ......................... 59

Section Three Troubles ............................................................................ 61
  3.1  TROUBLES WITH ADDRESSABLE DEVICES ................................... 61
  3.2  TROUBLES WITH SECURITY DEVICES ........................................... 62
  3.3  TROUBLES WITH SUPERVISORY DEVICES ..................................... 63
  3.4  TROUBLES WITH DISABLED ZONES ............................................. 64
  3.5  TROUBLES WITH THE AM2020/AFP1010 SYSTEMS ..................... 64
  3.6  TROUBLES WITH ANNUNCIATORS .............................................. 65
  3.7  TROUBLES WITH AFP-300/AFP-400 BELL CIRCUITS ...................... 65
  3.8  TROUBLES WITH AFP300/AFP-400 PANEL CIRCUITS ................... 66
  3.9  ACKNOWLEDGING TROUBLES .................................................. 67
      3.9.1  TROUBLE WITH NRT AND INA EQUIPMENT ......................... 67
      3.9.2  DEVICE MESSAGE TRANSLATIONS for the AFP-300/400 AND AFP-200 ......................................................... 67

Section Four  Read Status ................................................................. 75

Section Five  The Graphic Presentation Window ........................................ 79
    5.1  ACCESSING INFORMATION ABOUT DEVICES ............................. 80

APPENDIX A  WINDOWS NT® SECURITY DISABLE PROCEDURE .................. 81

APPENDIX B  WINDOWS NT® 4.0 INSTALLATION .................................... 82
CHAPTER ONE
INSTALLATION
SECTION ONE
NRT MOUNTING AND CONNECTIONS

The Network Reporting Terminal (NRT) is a listed computer with VGA graphics for displaying all network events. The NRT is used with the Notifier NOTI•FIRE•NET™ system. One model of the NRT is available; the NRT-586T, a high-performance tower style computer.

1.1 RELATED DOCUMENTATION

To obtain a complete understanding of the NRT features and related products or to become familiar with functions in general, make use of the documentation noted in Table 1.1-1. The Notifier document chart (DOC-NOT) provides the current document revision. A copy of this document is included with each shipment of Notifier products.

<table>
<thead>
<tr>
<th>TITLE</th>
<th>NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM2020/AFP1010 Fire Alarm Control Panel</td>
<td>15088</td>
</tr>
<tr>
<td>Liquid Crystal Display (LCD-80)</td>
<td>15037</td>
</tr>
<tr>
<td>Network Reporting Terminal (NRT)</td>
<td>15090</td>
</tr>
<tr>
<td>Intelligent Network Annunciator (INA)</td>
<td>15092</td>
</tr>
<tr>
<td>Universal Zone Coder Installation (UZC-256)</td>
<td>15216</td>
</tr>
<tr>
<td>Product Installation Document (CCM-1)</td>
<td>15328</td>
</tr>
<tr>
<td>Product Installation Document (MPS-TR)</td>
<td>15331</td>
</tr>
<tr>
<td>AM2020/AFP1010 Operator Instructions</td>
<td>15337</td>
</tr>
<tr>
<td>Notifier Device Compatibility Document</td>
<td>15378</td>
</tr>
<tr>
<td>Analog Fire Panel (AFP-200)</td>
<td>15511</td>
</tr>
<tr>
<td>Canadian Requirements for the AM2020/AFP1010</td>
<td>15631</td>
</tr>
<tr>
<td>Network Interface Board (NIB-96)</td>
<td>15666</td>
</tr>
<tr>
<td>Smoke Control Manual</td>
<td>15712</td>
</tr>
<tr>
<td>Analog Fire Panel (AFP-300/AFP-400)</td>
<td>50253/50259/50260</td>
</tr>
<tr>
<td>NR45-24 Charger</td>
<td>15760</td>
</tr>
<tr>
<td>Annunciator Control System</td>
<td>15842</td>
</tr>
<tr>
<td>Lamp Driver Modules (LDM)</td>
<td>15885</td>
</tr>
<tr>
<td>Voice Alarm Multiplex</td>
<td>15889</td>
</tr>
<tr>
<td>The XP Series Transponder System</td>
<td>15888</td>
</tr>
<tr>
<td>Network Adaptor Module (NAM-232)</td>
<td>50038</td>
</tr>
<tr>
<td>The UDACT Universal Digital Alarm Communicator/Transmitter</td>
<td>50050</td>
</tr>
<tr>
<td>FCPS-24/FCPS-24E Field Charger/Power Supply Installation, Operation and Application Manual</td>
<td>50059</td>
</tr>
<tr>
<td>Video Graphics Annunciator System (VGAS) Installation Manual</td>
<td>50251</td>
</tr>
<tr>
<td>Media Interface Board (MiB)</td>
<td>50255</td>
</tr>
<tr>
<td>Repeater (RPT)</td>
<td>50256</td>
</tr>
<tr>
<td>NOTI-FIRE-NET™</td>
<td>50257</td>
</tr>
<tr>
<td>Telephone/Panel Interface (TPI-232)</td>
<td>50372</td>
</tr>
<tr>
<td>XP5 Series Transponders</td>
<td>50786</td>
</tr>
<tr>
<td>Automatic Fire Alarm Warden Station Series Product Installation Drawing</td>
<td>50705</td>
</tr>
<tr>
<td>MMX-2 Installation Instructions</td>
<td>M500-03-00</td>
</tr>
</tbody>
</table>

Table 1.1-1 Related Documentation
1.2 NRT-NET INTERFACE CARD

The NRT communicates with **NOTI•FIRE•NET™** through the Network interface card (NRT-NET) and the Media Interface Board (MIB). The NRT-NET interface card plugs directly into a computer expansion slot located on the NRT computer. The MIB, which supports the physical connection to the network, plugs onto the NRT-NET card to complete the network interface. The NRT-NET interface card provides the following features:

- Allows the NRT computer to communicate on **NOTI•FIRE•NET™**
- Accepts the following choices of Media Interface Boards:
  - twisted-pair wire cable (MIB-W)
  - fiber optic wire cable (MIB-F)
  - twisted pair and fiber optic (MIB-WF)

1.3 NRT EQUIPMENT

The NRT computer has separate options available for use with this model. The equipment listed in Table 1.3-1 may be used with the NRT computer system it accompanies. The monitor, printer, and mouse must be installed in the same room as the NRT in order to comply with UL listing requirements.

<table>
<thead>
<tr>
<th>NRT-586T</th>
</tr>
</thead>
<tbody>
<tr>
<td>NRT wire data link (NRT-586TW) 115/230 VAC</td>
</tr>
<tr>
<td>NRT fiber optic link (NRT-586TF) 115/230 VAC</td>
</tr>
<tr>
<td>NRT fiber optic/wire data link (NRT-586TWF) 115/230 VAC</td>
</tr>
<tr>
<td>17-inch (431.8 mm) monitor (MON-17B) 115/240 VAC</td>
</tr>
<tr>
<td>21-inch (533.4 mm) monitor (MON-21) 115/240 VAC</td>
</tr>
<tr>
<td>Light pen pointing device (LP-2)</td>
</tr>
</tbody>
</table>

**Table 1.3-1 NRT Equipment Options**

1.4 PRIMARY AND SECONDARY POWER

The NRT requires primary AC power. Connection to the light and power service must be on a dedicated branch circuit, which must be labeled "Fire Alarm Circuit Control" at the circuit switch. The wiring for this circuit must be installed in conduit. Access to the switch must be limited to authorized personnel and the location of the switch must be identified on the PCLB-5 power cord locking bracket on the computer. Nothing but fire alarm equipment can be powered from the fire alarm circuit. The primary AC circuit wire run must run continuously, without disconnect devices, from the power source to the NRT. Overcurrent protection for this circuit must comply with Article 760 of the National Electrical Code as well as local codes. Where an NRT is required, the use of a supervised UPS listed for fire protective signaling is also required. When using a UPS, NRT input voltage must be 115 VAC. The use of 230 VAC is not permitted when employing a UPS.
1.5 CONNECTING THE NRT-586T

1.5.1 Connecting the NRT-586T

The following steps must be completed when connecting the NRT-586T (refer to Figures 1.5.1-1 and 1.5.1-2).

1. Cut off the plug end of the computer power cord.
2. Plug the socket end of the power cord into the computer.
3. Remove the screws from around the power supply of the NRT-586T (refer to Figure 1.5.1-1).
4. Attach the PCLB-5 enclosure without the cover to the back of the NRT-586T using these screws. (refer to Figure 1.5.1-2).
5. Install a 3/4-inch (19.05 mm) conduit and fitting in the knock-out hole of the Power Cord Locking Bracket cover. Refer to Figure 1.5.1-2.

**CAUTION:** Size the 3/4-inch (19.05 mm) conduit so the line cord can reach a junction box at the other end of the conduit.

6. Thread the power cord through the cover and conduit.
7. Attach the PCLB-5 cover to the PCLB-5 using the mounting screws supplied. Ensure that the PCLB-5 cover holds the power cord socket firmly in place (refer to Figure 1.5.1-2).
8. Connect the power cord to the HSP-121B power line protector as shown in Figure 1.5.1-3. **Note:** The HSP-121B power line protector must reside in a junction box.
9. Connect 115 V AC, 50/60 Hz primary power or 230 V AC, 50/60 Hz primary power to the HSP-121B as shown in Figure 1.5.1-3. Primary power connected to the HSP-121B (115 V AC or 230 V AC) depends upon the position of the voltage selection switch shown in Figures 1.5.1-1 and 1.5.1-2. All wiring must remain in conduit.

**WARNING:** Improper voltage selection can damage the NRT and void the warranty on the back cover of this manual.

10. Turn power switch on for the circuit.
11. Connect the monitor to the display adapter video connector on the back of the computer (refer to Figure 1.5.1-1). Connect the other end of the video cable to the monitor. The video cable is provided with screws for secure attachment.
12. Align the keyboard cable plug to mate with the notch in the computer's jack and insert cable.
13. Connect the mouse to the mouse port at the back of the NRT-586T.
14. Refer to Figure 1.6-1 for monitor power application.
NOTES

- The NRT-586T requires 115 VAC, 50/60Hz primary power or 230 VAC, 50/60 Hz primary power depending upon the position of the voltage selection switch shown in Figures 1.5.1-1 and 1.5.1-2.
- Where an NRT is required, the use of a supervised Uninterruptable Power Supply (UPS) is also required (see Figure 1.7-1).
- The NRT is not suitable for use as a receiving unit.
- The front power switch for the NRT-586T has been permanently fixed in the ON position.

Figure 1.5.1-2 Attaching the PCLB-5 to the NRT-586T

Figure 1.5.1-3 Connecting the Power Cord and Primary AC Power to the 46097 Power Line Protector
1.6 MONITOR INSTALLATION

1.6.1 Installing the MON-17B/MON-21

The following steps must be completed when connecting the MON-17B/MON-21 to the Junction Box and NRT-586T (refer to Figure 1.6.1-1).

1. Connect the AC Power Cord on the MON-17B/MON-21 to the HSP-121B Junction Box.
2. Connect the DB-15 video cable to the video card slot on the NRT-586T.

Note: The NRT CPU and the monitor connections may be made on the same HSP-121B: a separate HSP-121B unit for each is not required.

Figure 1.6-1 Installation of MON-17B/MON-21
1.6.2 Connecting a Monitor with the LP-2 Option to the NRT-586T

The following steps must be completed prior to connecting a monitor with the LP-2 option:

1. Connect the video tap to the VGA connector on the back of the NRT-586T (refer to Figure 1.6.2-1).
2. Connect the monitor SVGA cable (MON-17B/MON-21) to the video tap.
3. Attach the SYNC cable on the video tap to the SYNC input on the LP-2 option.
4. Connect the light pen cable to the PEN input on the LP-2 option.

![Figure 1.6.2-1 Connecting the Monitor with the LP-2 Option Board](image-url)
1.7 NRT UPS SUPERVISION

1.7.1 NRT Computer/Monitor/Printer UPS Supervision

Where a Network Reporting Terminal (NRT) is not ancillary, the use of a supervised 115 VAC Uninterruptable Power Supply (UPS) is required. Refer to Figures 1.7-1 and 1.7-2 for wiring information. A networked AM2020/AFP1010 or INA with an MPS-24A Power Supply must be located within three feet (.9144 m) of the UPS and wiring must be in conduit.

Figure 1.7-1 NRT Computer UPS Supervision
1.7.2 NRT Printer (only) UPS Supervision

Figure 1.7-2 NRT Printer UPS Supervision
1.8 STRAIN RELIEF

Strain relief for wiring attached to the NRT wire terminals on the MIB-W and the MIB-WF is provided by a protective cover (P/N 08275). The protective cover is supplied with both the MIB-W and the MIB-WF.

The following steps must be completed to connect the protective cover with strain relief:

1. Feed wires to be connected to the terminal block through the back or side access hole of the protective cover. The hinged covers of the unused access hole can be closed.

2. Attach the wires to the pluggable terminal block.

3. Snap the strain relief assembly over the pluggable terminal block. Use tie wrap to secure the wires to the protective cover (refer to Figure 1.8-1).

![Figure 1.8-1 Strain Relief Assembly](image-url)
SECTION TWO PERIPHERALS

2.1 CONNECTING A PRINTER

A printer can be connected to the NRT to print fire alarm and trouble signals (refer to Figure 2.1-1 and Table 2.1-1).

![Figure 2.1-1 Serial Port Connections for a Printer connected to NRT-586T](image)

To connect a PRN-4 printer to the NRT, a cable with the connections shown in Table 2.1-1 must be prepared.

<table>
<thead>
<tr>
<th>NRT DB9</th>
<th>Printer DB25</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>5</td>
<td>7</td>
</tr>
<tr>
<td>4 and 6 jumped together</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>20</td>
</tr>
</tbody>
</table>

Table 2.1-1 Printer Connections

NOTES

- Only one NRT (including keyboard, mouse, monitor, or any one of these) can be present on the network for other than National Fire Protection Association (NFPA-72 Local Service).
- Where an NRT is required, the use of a supervised 115 VAC UPS is also required (see Figure 1.8-1 or 1.8-2).
- Locate the printer in the same room as the NRT.
- This printer connection is not for use with VeriFire™. Refer to the VeriFire™ documentation for further information.
SECTION THREE SOFTWARE

3.1 INSTALLING THE NRT DATABASE SYSTEM

The following steps must be completed to copy the database files to the hard drive.

**NOTE**
The database is required for the NRT to work properly and must be installed before the NRT Software.

1. Log into Windows NT®.
2. Insert the first NRT database disk (must be a 3.5" disk) in drive A:\
3. In Program Manager under the File Menu, select Run...(for Windows NT® Version 3.51)
3a. Press Start on the bottom left-hand of the screen, select Run...(for Windows NT® Version 4.0)
4. Type A:\SETUP and press OK.

Follow the instructions on the screen. After all files have been copied to the hard drive, the following steps must be completed to install the NRT database system.

1. In Program Manager under the File Menu, select Run...(for Windows NT® Version 3.51)
1a. Press Start on the bottom left-hand of the screen, select Run...(for Windows NT® Version 4.0)
2. Type C:\NRT_TMP\SETUP and press OK.
3. At the ODBC Driver Pack 3.0 Setup dialog box press CONTINUE.
4. Press the button to the left of CUSTOM.
5. At the ODBC Driver Pack 3.0 custom dialog box deselect SQLSERVER by highlighting it and then double clicking with the mouse.
6. Deselect ORACLE in the same manner as described in the previous step. The check boxes should appear as shown below:

   - Desktop Drivers
   - SQLServer
   - Oracle
   - ODBC components

7. Highlight DESKTOP DRIVERS and press CHANGE OPTION.
8. At the ODBC Driver Pack 3.0 desktop drivers dialog box, deselect all options except for MS Access Driver and Engine Components as shown below and then press OK and CONTINUE.

   - MS Access Driver
   - Fox and dBase Driver
   - Paradox Driver
   - Text Driver
   - Excel Driver
   - Engine Components
   - Help Files

9. Press CONTINUE again to select the default Program Group name.
10. At the Data Sources dialog box, press SETUP...
11. At the ODBC Microsoft Access 7.0 Setup type NFN32 in the Data Source Name text box. Press OK. At this time the User Data Sources (Driver) text box contains NFN32(MICROSOFT ACCESS DRIVER (*.MDB)).
12. Press ADD and then OK. At the ODBC Microsoft Access 7.0 Setup, type NRT32 in the Data Source Name text box. Press OK. At this time the User Data Sources (Driver) text box contains NRT32(MICROSOFT ACCESS DRIVER (*.MDB)) beneath NFN32(MICROSOFT ACCESS DRIVER (*.MDB)), which was added in the previous step.
13. Press CLOSE. Press OK.
The following steps must be completed for the final clean-up to remove the files that were deselected in the previous steps.

1. Keep the NRT Database Disk 3 in Drive A:\.
2. In Program Manager under the File menu, select Run...(for Windows NT® Version 3.51)
2a. Press Start on the bottom left-hand of the screen, select Run...(for Windows NT® Version 4.0)
3. Type A:\CLEAN and press OK.

3.2 INSTALLING THE NRT SOFTWARE

Make sure to read the entire set of instructions prior to beginning the NRT software installation. The NRT software requires Windows NT® version 3.51 or higher. The following steps must be completed to install NRT software in Windows NT®.

Windows NT® is a registered trademark of Microsoft Corporation.

For Windows NT® Version 3.51 Users

1. Insert the first installation disk (must be a 3.5" disk) in drive A:\
2. In File Manager under the File Menu, select RUN…
3. At the Command Line prompt, type A:\Install.
4. Follow the NRT Installation program instructions.

For Windows NT® Version 4.0 Users

1. Insert the first installation disk (must be a 3.5" disk) in drive A:\
2. Click on the Start button, select Run...
3. At the Command Line prompt, type A:\Setup.
4. Follow the NRT installation program instructions.

NOTE
If the NRT is the Master Time Keeper on the network, installing this software will cancel the setting and a Master Time Keeper will not exist on the network. Enter the date/time in the NRT Local Programming Dialog Box for the NRT to become the Master Time Keeper again.

Complete the following steps if, after power-up, an "Error loading History View Filters" error is displayed:

1. Go to File Manager or Windows Explorer. Change to the directory that the NRT is installed in.
2. Delete the following files: nrt.cfg, nrt.sys, nrt.hfd, and nrt.psw.
3. Power-up the NRT. The NRT address will be 0. At this point all nodes have to be programmed into the NRT again, and the NRT local parameters have to be set up.

3.3 INSTALLING THE LANDesk CLIENT MANAGER

1. Run \Software\LDCM\Local\Setup.exe from the SE440BX Motherboard CD (purple and white CD)
2. Select the 333&More.ALF configuration.
3. Important: After the install is complete, double-click the LANDesk Client Manager icon in the system tray. Then select Configure Notifications from the Tools menu item. Uncheck the Fans Notification on the Basic Hardware tab.

3.4 INSTALLED PRINTERS

If there is a serial printer connected to the NRT but it is not printing; the printer may need to be installed in the software. The following steps must be completed to install a generic/text only printer correctly on COM1 (only for a Notifier printer).

For Windows NT® Version 3.51 Users

1. Exit the NRT application.
2. Enter the Windows NT® Program Manager.
3. Open the Windows NT® Print Manager by double-clicking on the Print Manager icon in Program Manger's Main group.
4. Select Printer, then Properties.
5. Press the Details button.
6. Select the checkbox, Print Directly to Ports.
7. Set the Priority to 99. Press OK to close the printer details.
8. Ensure that the Driver is set to Generic/Text Only and that Print To is set to COM1.
9. Press OK to close the Printer Properties.
10. Select EXIT from the Printer pull-down menu.

For Windows NT® Version 4.0 Users
1. Exit the NRT application.
2. From the Start Menu, select Settings, and then Printers.
3. Double click on the "Add Printer" icon.
4. The Windows NT® Installation Wizard will start to add the new printer.
5. Select the "My Computer" button, click next. The following items should be selected on the next screens.
   • The printer should be connected to COM1.
   • Select Generic text Only Printer.
   • Select Not Shared.
6. In the printer dialog box, highlight the printer just installed, right click and select properties.
   • select Scheduling, click "Print directly to Ports".

3.5 Installed Light Pen (LP-2)
If there is a light pen (LP-2) connected to the NRT-586T that is not responding, the light pen software may need to be installed. The following steps should be completed to install the light pen:

1. Exit the NRT application.
2. Insert the Light Pen Driver disk in drive A:\
3. In Program Manager under the File menu, select Run...(for Windows Nt® Version 3.51)
   3a. Press Start on the bottom left-hand of the screen, select Run...(for Windows NT® Version 4.0)
4. Type A:\ SETUP and press OK.

Follow the instructions on the screen. The LP-2 can be calibrated at any time by running WinCal from the LPI Light Pen Group window. For further information on installation, calibration or operation of the light pen, refer to the manual supplied with the LP-2 option.

3.6 Magnetic Tape Backup
File Directories on the NRT contain information specific for normal NRT operation. User-defined directories for capturing history files (.HIS) may also exist on the NRT. The files in these directories may be backed up to a magnetic tape unit.

The following directories on the NRT contain important information and should be included in the backup:

• C:\NRTNT
• C:\WINDOWS\SYSTEM32\DRIVERS

The following steps should be completed to create a tape backup:

1. Exit from the NRT start-up window to the Windows NT®.
2. Place a magnetic tape with a sufficient capacity in the tape drive. To determine sufficient capacity, compare the total size of the files to be backed up with the tape size using the Windows File Manager.
3. Start the Windows® backup and identify the appropriate directories to be backed up (see above).
4. Identify the magnetic tape drive as the destination for the backup and start the backup.

After the backup is complete, remove the tape and affix a proper label which identifies the contents and date of backup. Restart the NRT. Store the tape in a safe location away from strong magnetic fields. For more information on the magnetic tape backup system, refer to the user guide supplied with the tape unit.

**CAUTION!**
Exiting the NRT application disconnects the NRT from NOTI•FIRE•NET which leaves the building unprotected and the NRT not performing Life Safety functions. A firewatch is recommended in all areas where the NRT is designated as the primary or only reporting station.
CHAPTER TWO
PROGRAMMING
SECTION ONE
NETWORKING THE NRT

The Network Reporting Terminal (NRT) annunciates system signals on NOTI•FIRE•NET. Equipment that connects to NOTI•FIRE•NET and communicates with other equipment using the network will be referred to as a network node (for example: AM2020, AFP200 with NAM-232, AFP1010, INA, or NRT). NOTI•FIRE•NET is a peer-to-peer network (refer to Figure 1.0-1). NOTI•FIRE•NET nodes can be logically grouped together to form systems. Two types of systems are possible: the Command Center (a group of all nodes on the network) and a User-Defined System. For more information on NOTI•FIRE•NET, refer to the NOTI•FIRE•NET Manual.

The Command Center is a system that contains every node in the network. All nodes in the network must be programmed into the Command Center. Failure to program a node(s) into the Command Center will result in a trouble message.

The User-Defined System is a subset of the nodes in the Command Center. The User-Defined System can contain from one node up to all network nodes. A custom label can be programmed for each User-Defined System.

The NRT functions as an input/output device which allows the user to display and program nodes into the Command Center and the User-Defined System.

NOTE
A system is defined here as a grouping of nodes. Nodes are fire alarm control panels (AM2020/AFP1010, AFP-300/AFP-400, AFP200), NRTs, and Intelligent Network Annunciators (INAs). In this sense, a system is not a Fire Alarm Control Panel (FACP) unless defined as such (single node system with FACP). The Command Center and the User-Defined System will contain identical node addresses. For example, node 1 in both systems is the same physical control panel, NRT, or INA. A unique node address must be assigned at every network node.
SECTION TWO USER INTERFACE

2.1 THE SCREEN

The basic input/output element of the NRT program is the window (refer to Figure 2.1-1). There are three main elements to the window: Title bar, menu bar and work area.

Figure 2.1-1 Elements of the Window

The title bar indicates the name of the window. The menu bar lists the available menus. A menu contains a list of commands that the particular window permits.

Menus

Commands for the NRT are listed in menus refer to Figure 2.1-2. To access a menu, select (click once) on the menu from the menu bar. This opens the menu. From the menu, select a command. An Ellipsis (...) after a menu option indicates a dialog box will appear (refer to Figure 2.1-3). If the wrong menu is opened, press the menu bar again or press anywhere outside of the opened menu to close it.

Figure 2.1-2 The Menu

A dialog box is a window which either supplies information to the user or requests information from the user. After opening a dialog box, the user typically enters information, and presses either OK (to carry out the command) or Cancel (to abort the command).
2.2 USING THE MOUSE AND KEYBOARD

The mouse or keyboard may be used to move around the screen and perform different functions.

Using the Mouse

There are two ways to select an item from a menu with the mouse. The first way is to position the mouse over the item that is to be opened. Press once on the item and it will be highlighted. This is called selecting an item. After selecting an item, press Enter to make the item functional. An alternate way to make the item functional, is to position the cursor over the item and double-click the mouse button.

Some dialog boxes have "Edit Fields" that may be used to enter text. As an example, refer to the "Start Time" edit field in Figure 2.1-3. To enter text using the mouse, select the edit field then press on the keyboard button. This will display the keyboard dialog box (refer to Figure 2.2-1). Using the mouse, press the button of the numeral to be entered. When finished, press OK.

Using the Keyboard

Note that in the menu bar, one letter of each menu item is underlined. Press and hold down the ALT key to activate the menu bar and then press the letter that is underlined. This combination will open the select menu, etc. To move within a dialog box without using the mouse, press TAB to move to the right, and SHIFT+TAB to move to the left.
SECTION THREE
THE START-UP WINDOW

To start the NRT, select the group named Notifier (refer to Figure 3.0-1). Select the NOTI•FIRE•NET icon and press Enter or double-click to start the application. For more information on the Windows NT® environment, refer to Section Two “User Interface.”

CAUTION!!
Exit from the NRT software and exit from Windows NT® before turning off the NRT. Failure to do so could invalidate software settings.

The Notifier icon shown below can be found under Notifier in Program Manager for Windows NT® 3.51 or under Notifier on the Start Bar for Windows NT® 4.0 or higher. To launch the NRT software, double-click on the icon.

The Start-up window is the first window that appears after the NRT application begins communication on NOTI•FIRE•NET. The Start-up window supports changing passwords and accessing other NRT windows.

CAUTION!!
• While running NRT software, DO NOT run other software, including PC Tools, Screensavers and TSRs.
• DO NOT add disk doubling software at any time.

There are five menus available from the NRT Start-up window: File, Admin, Action, Window, and Help.

3.1 File Menu
The File Menu (refer to Figure 3.1-1) allows the user to Login, Logout, change password, or exit the NRT application.

<table>
<thead>
<tr>
<th>File</th>
<th>Action</th>
<th>Admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Logout</td>
<td>Change Password</td>
</tr>
<tr>
<td></td>
<td>Exit...</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3.1-1 The File Menu
Logging on to NRT
The Login command allows the user to gain access to the NRT. Both a user name and a password are required to log on (refer to Figure 3.1-2). When the NRT is first powered up, the initial user name is Notifier and the password is also Notifier. The first person to log on then becomes the super user, which is the top user account with permanent access to all NRT commands. After initial login, the super user password must be changed to something other than Notifier to ensure system security. The super user should then set up accounts with temporary passwords for all operators that will be accessing the NRT. Passwords can be up to 19 characters long.

Asterisks are displayed in place of characters when entering a password. After entering both the user name and password, press OK to accept the login information. If an error is made while entering either the user name or password during login, a quick warning beep sounds, and the password dialog box remains on the screen with the user name highlighted.

Logging Off the NRT
The Logout command is used to exit out of the NRT. Once logout has been selected, a warning display appears to confirm the logout command (refer to Figure 3.1-3). After pressing OK to continue logging out, the Login dialog box appears, asking for a user name and password. System commands will not be accessible again until a user logs onto the NRT.
**Change Password Command**

The Change Password command allows a user to change their current password. A password can only be changed by the user who owns the password. Not even the super user (the top user account with permanent access to all NRT commands) can change another user’s password.

When the Change Password command is selected, the change password dialog box (refer to [Figure 3.1-4](#)) prompts the user for old and new passwords. Asterisks will appear in place of the entered characters for both the old and new passwords. Type the old password. Type the new password and then retype it to verify the first entry. Press OK to accept the new password information.

![Figure 3.1-4 Change Password Dialog Box](#)

**Password Time-Out Feature**

After a user-defined time of inactivity, the NRT will require reentry of the user’s password before allowing any further actions to be taken. The password dialog box prompts the user for a password. At this point the user must type the password and press OK to regain access to system commands. This feature may be disabled under the "Disable Password Time-Out" option in the local NRT dialog box by any user with programming privileges.

**Exit Command**

The Exit command from the file menu exits the NRT program and places the user in the Windows NT environment. The user is prompted for a password. After entering the correct password a warning display indicates the user is exiting the NRT application (refer to [Figure 3.1-5](#)). The user should either press OK to exit the NRT application or press Cancel to abort.

![Figure 3.1-5 Exiting the NRT](#)

**CAUTION!!**

Leaving the NRT application disconnects the NRT from NOTI•FIRE•NET which leaves the building unprotected and the NRT not performing Life Safety functions.
3.2 Administrative Menu

The Administrative (Admin) menu (refer to Figure 3.2-1) allows the user to add, change, or delete user accounts, all of which are performed from the Account command. Initially only the super user can edit accounts; however, any user given access to the Account command will also have the ability to edit accounts.

![Figure 3.2-1 The Administrative Menu](image)

The Account command initially displays the Account List dialog box (refer to Figure 3.2-2) where all user accounts currently setup on the NRT are displayed. There is a maximum of 100 user accounts that can be setup on the NRT.

![Figure 3.2-2 Account List Dialog Box](image)

To set up a new user on the NRT, press the add user button. The new user dialog box appears, prompting for a new user name (refer to Figure 3.2-3). Enter a user name up to 19 characters long. Check boxes allow all system commands or all available nodes to be assigned at once to the new user account. Press OK to accept the new user name.

To add or delete commands from a user account, press the edit user button. The account edit dialog box appears with a listing of all commands and all nodes available on the NRT (refer to Figure 3.2-4). Pressing a check box beside a command selects or deselects it from the user account being edited. All nodes available on the system are displayed in the accessible nodes section. Only highlighted nodes are accessible to the user account. Pressing on a node selects or deselects it. After editing the user account, press OK to accept the changes.

To delete a user account from the NRT, highlight the account and press on the delete button from the account list dialog box.

**NOTE**

All nodes assigned to a given user will have the same set of commands available to them.
Figure 3.2-3  New User Dialog Box

Figure 3.2-4  Account Edit Dialog Box
Accessible commands from the Account dialog box (refer to Figure 3.2-4) are defined as follows:

**Reset**  Allows the function of system reset to be performed across the allowable network nodes.

**Acknowledge**  Allows the function of acknowledge step to be performed across the allowable network nodes.

**Signal Silence**  Allows the function of signal silence to be performed across the allowable network nodes.

**Exit**  Allows the user to exit the NRT application.

**Save Memo**  Allows the user to save a memo in the Memo Window. **NOTE:** This command will give the user access to the hard-drive and overwrite existing files.

**Delete Memo**  Allows the user to delete a previously saved memo. **NOTE:** This command will give the user access to the hard-drive and the ability to delete files.

**Account**  Allows the user to access account information.

**Select Screen**  Allows the user the ability to switch between different screens (windows) in the application.

**Select System**  Allows the function of system programming/read status to be performed across allowable network nodes.

**Point Program**  Allows the function of point programming to be performed across the allowable network nodes.

**Point Enable**  Allows the function of point enable/disable to be performed across the allowable network nodes.

**Module On/Off**  Allows the function of control on/off for output devices to be performed across the allowable network nodes.

**Point Remove**  Allows the function of point removal to be performed across the allowable network nodes.

**Upload**  Allows the user to upload a fire panel database to the NRT for storage.

**Download**  Allows the user to download a database stored on the NRT to a fire panel.

**Abort**  Allows the user to abort an upload or download.

**Schedule**  Allows the user to schedule an upload or download.

### 3.3 The Action Menu

From this menu, the user can perform Acknowledge, Signal Silence and Reset without being in the System Interface Window (refer to Figure 3.3-1).

![Figure 3.3-1 The Action Menu](http://www.tech-man.com)
3.4 The Window Menu

From the Window Menu, the user can access any other window in the program which includes the Start-up, System Interface, Active History, Stored History, Graphic History, Memo, Exchange (Upload/Download), and Graphic Presentation Windows (refer to Figure 3.4-1). These windows are explained in further detail in the following sections. Note: The Video Window option is not supported in this software release.

![Figure 3.4-1 The Window Menu](image)

3.5 The Help Menu

The Help menu allows the user to access a help file without exiting an application. Table 3.5-1 details the commands from the Help menu (refer to Figure 3.5-1). The help system contains this manual online.

<table>
<thead>
<tr>
<th>The Command...</th>
<th>Does the Following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Manual F1</td>
<td>Opens Acrobat Reader with the NRT Manual in .PDF format</td>
</tr>
<tr>
<td>How To Use Help</td>
<td>Instructions on how to use the help windows.</td>
</tr>
<tr>
<td>About NRT</td>
<td>Displays copyright and part number for the software.</td>
</tr>
</tbody>
</table>

Table 3.5-1 Help Menu Commands

![Figure 3.5-1 The Help Menu](image)
SECTION FOUR

THE SYSTEM INTERFACE WINDOW

The System Interface Window is an advanced Signal Display, Read Status, and Programming interface to networked panels. This interface allows the user to simultaneously display and modify control panel user data. The System Interface Window is displayed from the Window Menu in the Start-up Window.

The System Interface Window (refer to Figure 4.0-1) displays the system(s) in the network. Each system contains one alarm and one trouble window. The Command Center appears in the top half of the System Interface Window and the User-Defined System appears in the bottom half of the window. If no User-Defined System is present, the bottom half of the System Interface Window remains blank.

Each system has three function buttons; Acknowledge, Signal Silence, and Reset. The Acknowledge button acknowledges events in the system. Events are prioritized in the following order:

1) Fire Alarm
2) Security Alarm
3) Supervisory Signal
4) Trouble Signal

Events are displayed in the order they are received, but higher priority events will override lower priority events. If signals of the same type at the same loop address are received at the same time, the signal with the lowest node number has the highest priority. The Reset button resets the system and the Signal Silence button silences the entire system.

The top line of each message box also contains counters for New Alarms, Total Alarms, New Troubles, and Total Troubles. New Alarms/New Troubles displays the number of alarms/troubles since the last acknowledge. Total Alarms/Total Troubles displays the current total number of alarms/troubles.

The current network time and date (within second resolution) is displayed on all windows of the NRT in the upper right-hand corner above the alarm and trouble windows.

Figure 4.0-1 The System Interface Window
The File Menu
From the File menu, the user can Login, Logout, Change Password, or Exit the NRT application. These commands are described in Section Three of this chapter, “The Start-up Window.”

The Action Menu
From this menu, the user can perform Acknowledge, Signal Silence and Reset without being in the System Interface Window.

The Administrative (Admin) Menu
From the Admin menu, any user with access to the Account command can set up new operator accounts, add privileges to, or delete privileges from current users.

The Select Menu
From the Select menu, the user can display the Select System dialog box.

The Window Menu
From this menu, the user can select the Start-up, Active History, Stored History, Graphic History, Memo, Exchange (Upload/Download), or Graphic Presentation Window. Selecting Start-up returns the user to the Start-up Window.

4.1 THE SELECT SYSTEM DIALOG BOX
After selecting System from the Select menu, the Select System Dialog box appears (refer to Figure 4.1-1). From this window, the user can add, edit, and delete systems and nodes in the network. The user may also perform read status or programming functions on various nodes.

![Figure 4.1-1 The Select System Dialog Box](image-url)
**System and Node Buttons**

The System and Node buttons let the user add, edit, or delete a User-Defined System. The user may also edit systems, delete systems, add nodes to systems, delete nodes from systems, and edit nodes in systems.

The Add System button from the Select System Dialog lets the user add a User-Defined System to the network. After the user presses this button, the Program Custom Label dialog box displays and prompts for the name of the new custom label (refer to **Figure 4.1-2**). After entering the name of the new label (system), the program displays the new system under the Command Center. Also note that in the Select System Dialog box, Dormitory is added (refer to **Figure 4.1-3**).

![Figure 4.1-2 Program Custom Label](image)

**Figure 4.1-2 Program Custom Label**

![Figure 4.1-3 Adding a User-Defined System](image)

**Figure 4.1-3 Adding a User-Defined System**

**NOTE**

Currently, only one User-Defined System may be added to the network. An error message appears when the user attempts to add more.
Edit System allows the user to change the name of the User-Defined System.

Delete System allows the user to delete a User-Defined System from the NRT. Press the Delete System button. Select the User-Defined System; then select Delete System. A warning box will appear. Select OK to delete or select Cancel to abort.

Add Node lets the user add a node to a system. From the Select System dialog box, select the system where the node is to be added. Press the Add Node button. A list of all available nodes will appear. The list displays Node 1 (N1) through Node 255 (N255). Use the PageUp and PageDown buttons to scroll through the list. Press the node to be added. The Node Type Selection dialog box will appear (refer to Figure 4.1-4). The user can program the node to be one of five node types: AM2020, AFP1010, AFP-300/AFP-400, AFP200, INA, and Remote NRT. After selecting the applicable node type, press OK.

NOTES
1. Nodes may be added to a User-Defined System if the node is already programmed into the Command Center.
2. A local NRT node will be present in the Command Center. To bring the NRT on line, double-click on the local NRT node and change the node address to a value between 1 and 249. A Local NRT node cannot be programmed using the Select System dialog box.
3. If a node type is programmed incorrectly, the NRT will automatically switch the node type to the correct type (i.e., an AM2020 programmed as an AFP1010 will be switched to an AM2020).
4. If the software is upgraded from a version prior to M2.8, and the local NRT was programmed into the address range 250-255, upon powerup the local NRT node address will reset to zero.

The Command Center must contain all nodes present on the network. The user must program all nodes into the Command Center before programming the User-Defined System.

Edit Node allows the user to change the type of a particular node on the network.

![Node Type Selection](image)

**Figure 4.1-4 Node Type Selection Dialog Box**

**GENERAL PROGRAMMING NOTES**
1. Programming / After Status actions can only be completed once every 5 seconds. If they are attempted faster than that, a dialog box with the following information will be displayed: "Command could not be executed. Please try again."
2. If for some reason a message cannot be transmitted over the network, a dialog box with the following information will be displayed: "Command could not be executed. Please try again."
3. After a group disable command has been executed from the NRT, all further programming actions will be inhibited until the command has been completed on the FACP. If programming actions are attempted during that time period, the NRT will display the following dialog box: "All programming functions are inhibited while group zone disable / enable is in progress."
To view nodes currently programmed into the system, double-click on the System button in the Select System Dialog box to display a list of the nodes (refer to Figure 4.1-5). Double-clicking the System button shows a list of the systems.

The **Delete Node** button deletes a node from a system. To do this, select the node to be removed. Press the Delete Node button from the Select System Dialog box. A warning box will appear stating that the node will be removed from the system.

**NOTES**

- *The user cannot remove a node from the Command Center without removing it from all other User-Defined Systems. If this is attempted, an error message will appear.*
- *The user cannot change the name of the Command Center.*
- *The user cannot remove the Local NRT node.*

**The Cancel Button**

The Cancel Button places the user into the System Interface Window.

**The OK Button**

With a node selected, the OK button places the user in a Node dialog box from which Read Status/Programming can be performed.

**Figure 4.1-5  Programmed Nodes in a System**

### 4.2 NODE DIALOG BOXES

From the Node dialog boxes, the user can program sensors, annunciators, modules, fire alarm control panels, zones, and peripherals for the various nodes.

**NOTE**

INA, Remote NRT, AFP-300/AFP-400 and AFP-200 programming is not available in this software release.

**The AM2020 and AFP1010 Dialog Boxes**

From the AM2020 and AFP1010 dialog boxes, the user can program sensors, annunciators, modules, fire alarm control panels, zones, and peripherals (refer to Figure 4.2-1). For further information about programming parameters refer to Chapter Three of the AM2020/AFP1010 Manual (Document 15088).

**Figure 4.2-1  AFP1010 Dialog Box**
Sensor Button
To program a detector from the NRT, press the Sensor button. Enter the address of the detector to be programmed. Press OK. The Detector dialog box will appear (refer to Figure 4.2-2). The title of the dialog box contains the device, network address and whether the point being displayed is installed.

Figure 4.2-2 Detector Dialog Box

Enter the detector label, type, annunciator mapping (if any), control-by-event (use ( ) if none), sensitivity settings, tracking, verification and day/night sensitivity information. When all information is entered, press the Program button (refer to Figure 4.2-3). Press the Close button to return to the Node dialog box.

**NOTE**
The Disable button does not appear until the point is programmed.

Using Dialog Box Buttons

- **Program** - stores entered data into the NOTI•FIRE•NET.
- **Back** - returns the user to the System Interface Window.
- **Filter** - is not implemented in this release.
- **Prior** - moves the user to the previous device (example: L1D1 is displayed when programming L1D2).
- **Remove** - removes current device from programming.
- **Close** - returns the user to the Node dialog box.
- **Undo** - is not implemented in this version.
- **Help** - opens the help file.
- **Next** - moves the user to the next device (example: L1D3 is displayed when programming L1D2).
- **Displays keyboard** for entering information.

Figure 4.2-3 Dialog Box Buttons
Annunciator Button

To program an annunciator panel from the NRT, press the annunciator button. Enter the address of the annunciator panel (for example, A1) and press OK. The Annunciator Panel dialog box appears (refer to Figure 4.2-4), where the user can enter a custom label for the annunciator. After entering the label, press Program. Press Close to return to the Node dialog box.

![Figure 4.2-4 Annunciator Panel Dialog Box](image)

To program an annunciator point from the NRT, press the Annunciator button. Enter the address of the annunciator point (for example, A1P1). Press OK. The Annunciator Point dialog box will appear (refer to Figure 4.2-5). Select the type of point by selecting one of the choices under the Type drop-down menu and then press Program. To return to the Node dialog box, press Close. For more information on annunciator type I.D.s, refer to Chapter Three of the AM2020/ AFP1010 manual, Document 15088.

![Figure 4.2-5 Annunciator Point Dialog Box](image)
Module Button

The module button allows the user to program a monitor or control module from the NRT. To do this, press the Module button from the Node dialog box. Enter the address of the module to be programmed. Press OK. Depending on what information was entered in the type field, either the monitor module dialog box (refer to Figure 4.2-6) or the control module dialog box (refer to Figure 4.2-7) will appear. As with the detector and annunciator dialog boxes, the address and whether the device is installed is displayed in the title bar. Enter the custom label, type, annunciator mapping (if any) and control-by-event (use () if none.) Note that after selecting the type of module, a dialog box will appear asking to begin installation. Press OK. Other options regarding the type of module being installed will appear. When finished entering all applicable information, press Program. Then press Close to return to the Node dialog box.

The Disable button shows the state that the module will be put in when the button is pressed. If the Disable button shown in Figure 4.2-7 is pressed, the module will be disabled. After completing the action, the button will change to Enable. **Note:** Pressing the Disable/Enable button or the Activate/Deactivate button completes the action. The Program button should not be pressed in conjunction with these buttons.

**NOTE**

The Disable button does not appear until the point is programmed. For control modules the Activate button does not appear until the point is programmed.

![Monitor Module Dialog Box](image_url)

**Figure 4.2-6 Monitor Module Dialog Box**

![Control Module Dialog Box](image_url)

**Figure 4.2-7 Control Module Dialog Box**
FACP Button

FACP allows the user to program FACP-wide Alarm Verification Time (seconds), Signal Silence Inhibit Time (seconds), Signal Cut-Out Time (seconds), AVPS installed, Zone Boundary, miscellaneous FACP information, and NFPA Listings from the NRT. From the FACP dialog box, the user can also program LIB SLC loop information and battery specifications (refer to Figures 4.2-8, 4.2-9, and 4.2-10).

SLC opens a dialog box where the user may enter LIB board and wiring style information. Also, Local Mode maximum device information can be entered here.

Battery opens a dialog box where the user may enter information about the battery.

CAUTION

When a LIB is removed during programming, all points stored on that affected LIB will also be removed. Programming information for installed points can be stored in a VeriFire™ database prior to removal of a LIB. Use of the VeriFire™ application for the reprogramming of previously removed points is highly recommended.

Figure 4.2-8  FACP Dialog Box

Figure 4.2-9  SLC Loop Dialog Box
Zone Button

The Zone button allows the user to program zones from the NRT. From the Node dialog box, press the Zone button. Enter the number of the zone to be programmed. Press OK. The Zone dialog box will appear (refer to Figure 4.2-11). The user must enter a label, type of zone, annunciator mapping (if any), control-by-event, and cooperative control-by-event (use OR( ) if none). After entering applicable information, press Program. Press Close to return to the Node dialog box. The cooperative control-by-event (CCBE) dialog box is only accessible for reverse zones.

**NOTE**
The Disable and Group Zone Disable buttons do not appear until after the zone is programmed.

---

**Figure 4.2-10** Battery Dialog Box

**Figure 4.2-11** Zone Dialog Box
Local NRT Node Dialog Box

Local NRT parameters can be programmed by selecting the local NRT node from the Select System dialog box and pressing OK or double-clicking the node. The Local NRT Program dialog box appears (refer to Figure 4.2-13). From this dialog box, the user can program the address, thresholds, ports supervision, and settings for the local NRT node. When finished entering all the information press Program. Press Back to go to the System Interface Window. After programming the Local NRT, press Close.

**NOTE**

Receive Mode is not implemented in this release. When an NRT is used with the NOTI•FIRE•NET system, all network nodes must be configured for block acknowledge. Nodes configured for receiving unit mode will not function properly and troubles will not be acknowledged.

The local NRT date and time can also be modified from this dialog box. The frequencies for alarm and trouble sounds may be modified solely for the NRT, with no effect to any fire panel. Setting different frequencies for alarms and troubles makes them distinguishable from each other. At least a 200 Hz difference is required in the lower Hz range (less than 2000) so that the alarm and trouble sounds can be distinguished from each other. Fan supervision is not required on the NRT and should be disabled. The default (checked) enables fan failure troubles on the NRT. Uncheck the Fan Supervision check box in the Local NRT Node Dialog Box.
**Figure 4.2-13 Local NRT Program Dialog Box**

- **Address:** NOTI•FIRE•NET address.*
- **Threshold:** MIB communication thresholds for Ports A and B. MIB-WF only requires threshold settings for Port A.
- **Ports Supervision:** NOTI•FIRE•NET wiring configuration.
- **Settings:**
  - Data Refresh: Allows update of graphic screens after a node is added to the network.
  - UPS Supervision: Uncheck UPS Supervision; it is not required.
  - Receive Mode: Settings: Data Refresh allows update of graphic screens after a node is added to the network.
- **Timer:** Change the time and date of a specific node.**
- **Sound (Hz):** Define separate alert tones for alarm and trouble conditions.
- **Password:** Allows the user to disable or enable the automatic password time-out feature and set the time-out value if the feature is enabled.

* To take the Local NRT off-line (stop communicating on the network), set the local NRT address to 0.

** CAUTION!!**

Taking the Local NRT off-line causes the NRT to stop communicating with the NOTI•FIRE•NET network, which leaves the building unprotected and the NRT not performing Life Safety functions.

** The last AM2020/AFP1010, AFP-300/AFP-400, INA, or NRT on NOTI•FIRE•NET to have its time/date manually changed becomes the network master for clock synchronization. To avoid confusion, it is important to decide which node will be the master clock keeper and only change the time and date on that node. The clocks are synchronized every hour. The network time and date appears in the upper right-hand corner of all NRT windows. The node address of the master time keeper is displayed in the Node field of the Timer box. If a node address of 0 is displayed in the Node field, the NRT is not the master time keeper, and did not receive a time update from the network. If this condition persists for more than 3 hours, enter the time/date on a node to re-establish a master time keeper.
SECTION FIVE THE ACTIVE/STORED HISTORY WINDOW

The user may select the Active History or Stored History Window from the Window Menu in the System Interface Window. The history buffer is a file that records all the operator actions and all events (alarms and troubles) that have occurred in the system. The Stored History Window is identical to the Active History Window except the Stored History Window does not act on files currently receiving history information.

The history buffer displays a list of events from the oldest event (top screen, first page) to the newest event (bottom screen, last page). When the history buffer is viewed, alarms appear in red text, security alarms appear in blue text, troubles appear in yellow text, and operator actions and non-reporting points appear in black text. All operations completed within the upload/download window will also be logged into the history buffer, including initiation of upload/download and confirmed cancellation. As a minimum, the upload/download operations in the history buffer will contain functions executed, operator log-in, and the date and time. A sample history is shown in Figure 5.0-1.

In addition to displaying the entire history file from start to finish, it is also possible to display only specific information of importance. By selecting the History Filters menu from the Options menu, filters can be applied to the history file. For example, a user may choose to display alarms, troubles, supervisory, or security conditions. Additionally, the user may choose to display events from a certain time, date, node, loop or device, and see which user was active during certain events.

The History Filter dialog box is shown in Figure 5.0-2. The Start Time/Stop Time and Start Date/Stop Date can be used to display a certain range of events. By using Active Filter Passes, only a certain type of event will display. After selecting the type(s) of events and pressing OK, a filtered history file will be displayed.

Large history files can take a long time to process. If filters are applied to a large history file, or a large history file is viewed in the stored history window, an hourglass will appear next to the cursor. This signifies that the history file is being processed. During this process certain history window comments will be disabled. Other windows can be invoked at this time.

Figure 5.0-1 The Active History Window
5.1 CHANGING THE ACTIVE HISTORY BUFFER

From the Active History Window, the user can start a new history buffer or open an existing history buffer as the currently active history buffer. From the File Menu, select New to open a new file as the currently active history buffer.

After selecting New from the File menu, the File Save As dialog box appears. Enter the name of the new history buffer file with file extension “.HIS.” The user can also change the file directory to save the file in a different location. When finished, press OK to accept; or Cancel to abort.

To open an existing file as the currently active history buffer, select Open… from the File menu. The File Open dialog box will appear. After selecting an existing file, press OK to accept this information or Cancel to abort. Note: History files may be backed up using the magnetic tape backup system (refer to Section Three in Chapter One of this manual).

5.2 CHANGING THE STORED HISTORY FILE

To view a different stored history file, select Open… from the File menu in the Stored History Window. The File Open dialog box will appear. Select a different file to view and press either OK to accept or Cancel to abort.

5.3 PRINTING THE ACTIVE/STORED HISTORY WINDOW

The printing option lets the user print an Active History Window or a Stored History Window (refer to Figure 5.3-1). The window print contains all events that take place up to the printing confirmation. When printing, note the following:

- The user may only print one window at a time.
- The window print exceeds the usual width of incoming events. To avoid printer line wrap, set the printer pitch to a minimum of 12 characters per inch (CPI) (12 characters per 25.4 mm).
- The window print format differs from the active display window.

To print a window, do the following:

1. Select and display the desired window.
2. Select the Print Command; confirm the active window in the Print dialog box, and press OK.

The application prints the active window as the network processes other activities.

NOTE

The Print menu item is disabled while printing.
Figure 5.3-1 Sample Window Print

Note the following items on the sample print in Figure 5.3-1:

- Start banner – contains the events at the start of printing.
- Path and name – lists the directory and user-defined file name of the window print.
- Line numbers – lists the events as they occur during printing.
- End banner – lists new events that occurred during printing.

IMPORTANT!!

1. It is possible to print the history file with history filters applied. The printout must be completed before the history filters are removed when printing specific events.

2. The print setup dialog should only be used if problems are experienced while trying to print large files such as the history files. The delay setting (lines per second) can be increased or decreased to help speed up printing or to keep the system from freezing up during large print jobs. The minimum delay setting allowed is 3 seconds and the maximum is 300 seconds. The minimum line setting is 1 line and the maximum is 40 lines. In the print setup dialog box, the best setting for the PRN-4 printer is the default 2 lines per 3 seconds. If you experience problems during printing, contact your Notifier representative.
5.4 THE GRAPHIC HISTORY WINDOW

As an alternative to displaying a list of events in text format from the history file, the user can display this information in a graphic format. To do so, select Graphic History from the Window Menu (refer to Figure 5.4-1).

![Figure 5.4-1 The Graphic History Window](image)

From the Graphic History Window, the user can display the active history buffer or a selected history buffer file (.HIS) as a graphic. To display a history file, choose Open from the File menu. The File open box will appear. After selecting a file, press OK to accept; or press Cancel to abort. After pressing OK, the Graphic History Selection dialog box appears. From the Graphic History Selection dialog box, the user can choose to display only a certain year, month, or day and a number of different graphs, such as bar graph, point graph, line graph, or spline graph. Only alarms, only troubles, or both may be displayed. After selecting this information, press OK. The information will then be displayed graphically on the screen. To change the graph format, select Show Graph… within the Options menu and the Graphic History Selection dialog box will display (refer to Figure 5.4-2).

![Figure 5.4-2 The Graphic History Selection Dialog Box](image)
SECTION SIX THE MEMO WINDOW

The Memo window is a text editor which allows the user to create or edit files used as operator logs. These files have a .TXT file extension and can be up to 64K file size.

The File Menu
The file menu allows the user to create new, open, save, or delete text files.

The Edit Menu
The Edit menu allows the user to edit text through the Undo, Cut, Copy, Paste, Delete, Clear, Find … , Replace … , and Next commands.

The Action Menu
From this menu, the user can perform Acknowledge, Signal Silence, and Reset without being in the System Interface Window.

The Window Menu
From the Window Menu, the user can access any other window in the NRT program.
The Upload/Download Window is accessed from Exchange in the Window Menu of the System Interface window. The Exchange feature allows the user to transmit an entire database from a fire alarm panel to the NRT and download an entire database from the NRT to the panel.

**NOTE**

All operations completed in the Upload/Download Window will be logged into the Active History Window.

The Upload/Download graphic window contains the Node window, Status window, a Logging window (see Figure 7.0-1) and a Percentage Complete window. The Node window displays the address of the current node being uploaded/downloaded. The Status Window displays system managers for the current node being uploaded or downloaded. The Percentage Complete window displays how the upload/download has progressed. The Logging Window displays actions, errors, and warnings. Warnings are displayed in yellow and include CBE or CCBE equations incorrectly stored in the database. Errors are displayed in red. Errors are items that prohibit the upload/download feature to function such as nodes going off-line, abort function executed, or nodes not responding with the data requested by the NRT.

![Figure 7.0-1 The Upload/Download Graphic Window](image)

The Upload/Download window contains buttons used to initiate the upload/download process (see Figure 7.0-1) The Upload button initiates an upload, the Download button initiates the download, the Abort button will cancel the current process, and the Schedule button allows the user to schedule monthly uploads (see Section 7.2). Upload, download, abort, and schedule may also be selected from the Exchange menu in the Upload/Download window (see Figure 7.0-2).

![Figure 7.0-2 The Exchange Menu](image)
7.1 Upload

Only one node may be uploaded at a time and no catastrophic failures such as LIB Communications Trouble can exist on the node being uploaded. Catastrophic failures cause the fire panel to reboot every 15 minutes, causing the node to go off line and thus aborting the upload process. The Read Status and Programming functions will be disabled for any node currently being uploaded, but can be performed on any other node. All fire protection is enabled during an upload.

To begin an upload, press the Upload button. A current database must be opened using the Open button, or a new database created using the New button and a node selected. If a current database is opened and information for the selected node is already stored in the database, all current node information in the database will be deleted before the upload proceeds. Press the Start button to initiate the upload process. If the node selected for upload is not an AM2020 or AFP1010 panel, a dialog box will appear indicating that upload for the selected node cannot be implemented (see Figure 7.1-1). The Upload/Download feature is not currently implemented for INAs, AFP-200s, or other NRTs.

![Figure 7.1-1 Upload Dialog Box](image)

**NOTE**

During the NRT read status, the fire panel does not send data for any points for which there is no LIB SLC loop installed or programmed into the panel. Before sending a message to the LIB SLC loop for a point read, the fire panel's CPU checks to make sure the LIB is installed. Points that have been programmed into the panel but have no corresponding LIB SLC loop, will cause the upload to abort.

7.2 Scheduling Uploads

The NRT has a scheduling feature which allows the user to upload all or some panels at a specified time and date. Panels are uploaded sequentially, starting with the lowest node address. Scheduled uploads are differentiated from user-initiated uploads in the active history window.

To schedule an upload, press on the Schedule button in the Upload/Download window or select Schedule from the Exchange menu. The Schedule Upload dialog box will appear (see Figure 7.2-1).
Uploads can be scheduled at a specific time only once or once a month. The Time field in the Schedule Upload Dialog Box requires 24 hour (military) time. To alleviate the problem of months with 28, 30, or 31 days, the user may only choose days between the 1st and 28th of the month. The Schedule Upload dialog box contains a list of all the AM2020 and AFP1010 panels that are programmed into the NRT. All nodes or a user-defined group of nodes may be chosen for the scheduled upload. Nodes may be added to or deleted from the available node list by pressing the open, delete, or next buttons.

### 7.3 Download

Only one node may be downloaded at a time and no catastrophic failures such as LIB Communications Trouble can exist on the node receiving data. Catastrophic failures cause the fire panel to reboot every 15 minutes, causing the node to go off line and thus aborting the download process. The Read Status and Programming functions will be disabled for any node currently being downloaded, but can be performed on any other node. **Warning:** *Fire protection and life safety functions are limited during a download.*

Downloading is initiated by pressing the Download button. A read status determines which LIB SLC loops are programmed into the panel and only points with a corresponding loop can be downloaded to the panel.

During the download process, points are either programmed or reprogrammed. False alarms can occur due to incorrect or partial downloads. The user must thoroughly check the programming information prior to initiating a download.

### 7.4 Abort

Pressing the abort button will abort the current upload or download process. Aborting the process leaves a partial database in the panel (during download). **CAUTION:** *If the download is aborted, the fire panel may be in a corrupt state and the life safety protection provided by the panel may not operate correctly. If a download is aborted, the fire panel will have to be reprogrammed.* A confirmation dialog box will be displayed after pressing the Abort button, asking the user if they want to abort the upload/download operation. If the user chooses OK, the upload/download process will stop. If the user chooses Cancel, the process will continue. Confirmed abort actions will appear in the history buffer and will be displayed in the Logging window of the Upload/Download window.
SECTION EIGHT
THE GRAPHIC PRESENTATION WINDOW

The Graphic Presentation Window, accessible from any window, allows the user to display floor plans in which device information is embedded. When a device goes into alarm or trouble, the Graphic Presentation Window displays the event by flashing and changing the color of the device that goes into alarm/trouble. The user can also obtain device information, view bitmapped (.BMP) graphics, and perform Read Status of each device.

8.1 APPLYING ATTRIBUTES TO A CAD FILE

To program devices for use with NRT software, use CAD software that supports attributes, creates blocks, and exports CAD files in the .DXF file format. The programmer must have floor plans of the site (in a CAD program) and locations of devices.

NOTE
All CAD drawings must be saved using Autocad version 12 or older, or Autocad Lite 2.1 or older. The NRT does not recognize any newer file formats.

Enter every device in a CAD drawing as a block insert using the CAD program's "Make Block" or similar function. During the block insert function, the program prompts for the following three attributes:

- Information (optional)
- Picture (optional)
- Address

The Information attribute contains the path to the name of a text (.TXT) file unique to each device. TXT files can be created from the Memo Window (see Section Six of this chapter). The .TXT file can contain any character information that the end-user wants to access from the screen display window.

The Picture attribute contains the path to the name of a bitmap (.BMP) file unique to each device. This .BMP file can contain any graphic image that the end-user wants to access from the screen display window.

The Address is the address of the device on the network. Make sure to enter the node number, loop number, and device number (for example, N3L2D24).

After entering all devices into the CAD drawing as inserted blocks, export the drawing from the CAD program as a .DXF file. Create a subdirectory on the C: drive of the NRT where all .DXF files can be placed. Place this .DXF file into the subdirectory.

NOTE
The NRT graphics software will not function properly if more than one block is inserted for any single device.

8.1.1 The AFP-300/AFP-400

The AFP-400 is a two loop panel that contains 4 bell circuits and 64 panel circuits. The AFP-300 is a single loop panel that contains 4 bell circuits and 64 panel circuits. To add these point types to the NRT Graphic Presentation Window, they must be addressable in the Graphics Window on the standard node, loop, device address format. For this purpose, Loop 3 is reserved for bell and panel circuits for AFP-300/AFP-400 panels. Reference the table on the following page to add these devices to the Graphic Presentation Windows:
8.2 PROGRAMMING THE NRT

The .DXF file created from the CAD drawing will be divided into graphic screens that will be displayed in the NRT Graphic Presentation Window. The NRT saves each screen background as a bitmap (.BMP) file, and all devices and device information in a .DXF file. This allows the NRT to quickly display the screen backgrounds using the .BMP file and to immediately display troubles and alarms because the .DXF files can be quickly scanned quickly with no background data.

Programming graphic screens into the NRT requires the following three steps:
1. Create the background file and hide or remove all devices.
2. Install the background file and create the bitmap file.
3. Create the device file and remove the background.

The diagram in Figure 8.2-1 illustrates this process.

<table>
<thead>
<tr>
<th>AFP-300/AFP-400 Address</th>
<th>Graphic Presentation Widow Address</th>
<th>AFP-300/AFP-400 Address</th>
<th>Graphic Presentation Widow Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bell Circuit 1</td>
<td>L3M1</td>
<td>Panel Circuit 4-7</td>
<td>L3M39</td>
</tr>
<tr>
<td>Bell Circuit 2</td>
<td>L3M2</td>
<td>Panel Circuit 4-8</td>
<td>L3M40</td>
</tr>
<tr>
<td>Bell Circuit 3</td>
<td>L3M3</td>
<td>Panel Circuit 5-1</td>
<td>L3M41</td>
</tr>
<tr>
<td>Bell Circuit 4</td>
<td>L3M4</td>
<td>Panel Circuit 5-2</td>
<td>L3M42</td>
</tr>
<tr>
<td>Panel Circuit 1-1</td>
<td>L3M9</td>
<td>Panel Circuit 5-3</td>
<td>L3M43</td>
</tr>
<tr>
<td>Panel Circuit 1-2</td>
<td>L3M10</td>
<td>Panel Circuit 5-4</td>
<td>L3M44</td>
</tr>
<tr>
<td>Panel Circuit 1-3</td>
<td>L3M11</td>
<td>Panel Circuit 5-5</td>
<td>L3M45</td>
</tr>
<tr>
<td>Panel Circuit 1-4</td>
<td>L3M12</td>
<td>Panel Circuit 5-6</td>
<td>L3M46</td>
</tr>
<tr>
<td>Panel Circuit 1-5</td>
<td>L3M13</td>
<td>Panel Circuit 5-7</td>
<td>L3M47</td>
</tr>
<tr>
<td>Panel Circuit 1-6</td>
<td>L3M14</td>
<td>Panel Circuit 5-8</td>
<td>L3M48</td>
</tr>
<tr>
<td>Panel Circuit 1-7</td>
<td>L3M15</td>
<td>Panel Circuit 6-1</td>
<td>L3M49</td>
</tr>
<tr>
<td>Panel Circuit 1-8</td>
<td>L3M16</td>
<td>Panel Circuit 6-2</td>
<td>L3M50</td>
</tr>
<tr>
<td>Panel Circuit 2-1</td>
<td>L3M17</td>
<td>Panel Circuit 6-3</td>
<td>L3M51</td>
</tr>
<tr>
<td>Panel Circuit 2-2</td>
<td>L3M18</td>
<td>Panel Circuit 6-4</td>
<td>L3M52</td>
</tr>
<tr>
<td>Panel Circuit 2-3</td>
<td>L3M19</td>
<td>Panel Circuit 6-5</td>
<td>L3M53</td>
</tr>
<tr>
<td>Panel Circuit 2-4</td>
<td>L3M20</td>
<td>Panel Circuit 6-6</td>
<td>L3M54</td>
</tr>
<tr>
<td>Panel Circuit 2-5</td>
<td>L3M21</td>
<td>Panel Circuit 6-7</td>
<td>L3M55</td>
</tr>
<tr>
<td>Panel Circuit 2-6</td>
<td>L3M22</td>
<td>Panel Circuit 6-8</td>
<td>L3M56</td>
</tr>
<tr>
<td>Panel Circuit 2-7</td>
<td>L3M23</td>
<td>Panel Circuit 7-1</td>
<td>L3M57</td>
</tr>
<tr>
<td>Panel Circuit 2-8</td>
<td>L3M24</td>
<td>Panel Circuit 7-2</td>
<td>L3M58</td>
</tr>
<tr>
<td>Panel Circuit 3-1</td>
<td>L3M25</td>
<td>Panel Circuit 7-3</td>
<td>L3M59</td>
</tr>
<tr>
<td>Panel Circuit 3-2</td>
<td>L3M26</td>
<td>Panel Circuit 7-4</td>
<td>L3M60</td>
</tr>
<tr>
<td>Panel Circuit 3-3</td>
<td>L3M27</td>
<td>Panel Circuit 7-5</td>
<td>L3M61</td>
</tr>
<tr>
<td>Panel Circuit 3-4</td>
<td>L3M28</td>
<td>Panel Circuit 7-6</td>
<td>L3M62</td>
</tr>
<tr>
<td>Panel Circuit 3-5</td>
<td>L3M29</td>
<td>Panel Circuit 7-7</td>
<td>L3M63</td>
</tr>
<tr>
<td>Panel Circuit 3-6</td>
<td>L3M30</td>
<td>Panel Circuit 8-1</td>
<td>L3M65</td>
</tr>
<tr>
<td>Panel Circuit 3-7</td>
<td>L3M31</td>
<td>Panel Circuit 8-2</td>
<td>L3M66</td>
</tr>
<tr>
<td>Panel Circuit 3-8</td>
<td>L3M32</td>
<td>Panel Circuit 8-3</td>
<td>L3M67</td>
</tr>
<tr>
<td>Panel Circuit 4-1</td>
<td>L3M33</td>
<td>Panel Circuit 8-4</td>
<td>L3M68</td>
</tr>
<tr>
<td>Panel Circuit 4-2</td>
<td>L3M34</td>
<td>Panel Circuit 8-5</td>
<td>L3M69</td>
</tr>
<tr>
<td>Panel Circuit 4-3</td>
<td>L3M35</td>
<td>Panel Circuit 8-6</td>
<td>L3M70</td>
</tr>
<tr>
<td>Panel Circuit 4-4</td>
<td>L3M36</td>
<td>Panel Circuit 8-7</td>
<td>L3M71</td>
</tr>
<tr>
<td>Panel Circuit 4-5</td>
<td>L3M37</td>
<td>Panel Circuit 8-8</td>
<td>L3M72</td>
</tr>
<tr>
<td>Panel Circuit 4-6</td>
<td>L3M38</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 8.1-1 AFP-300/AFP-400 Bell and Panel Circuits

Network Reporting Terminal 15090-H 12/21/98
Step 1: Copy parent file (PARENT.DXF) with devices and background to work file (WORK.DXF) and hide or remove devices from work file.

Step 2: Install WORK.DXF into the screen tree, display, and press F2 to create bitmap file.

Figure 8.2-1 Example Process for Programming Graphic Screens

Use the example in Figure 8.2-1 above as a guideline for completing the steps outlined below.

**Step 1 - Creating the Background File**
The parent file (PARENT.DXF) is the CAD drawing which contains both the drawing background and the devices entered as block inserts. In Step 1, copy PARENT.DXF to a working file. In the example above (Figure 8.2-1), the copy is named WORK.DXF. Use a CAD program to hide or remove all devices from WORK.DXF. When finished, WORK.DXF should **only display the background** of the architectural drawing.

**Step 2 - Installing the Background File and Creating the Bitmap**
Step 2 installs the WORK.DXF background file and converts it into a bitmap (.BMP) file for use in the Graphic Presentation Window. Start the NRT software and go to Graphic Presentation under the Window menu. Go to the Select menu and select Screen. The Select Screen dialog box will appear (refer to Figure 8.2-2 below).

Figure 8.2-2 The Select Screen Dialog Box
In the Select Screen Dialog box, press the Add Screen button to begin creating the floor plan screens. The File Open dialog box will appear. Enter the path and name of the background work file created in Step 1 (WORK.DXF). The file name should appear in the Filename: box (refer to Figure 8.2-3). Enter an eight-character custom label. The custom label will later appear in the Select Screen dialogue box.

**Figure 8.2-3 The File Open Dialog Box**

Enter the CAD coordinates. The Maximum Horz., Maximum Vert., Minimum Horz. and Minimum Vert. entries are coordinates the programmer uses to indicate which part of the WORK.DXF will be displayed for this specific eight-character custom label. These coordinates are taken from the CAD drawing (units). To view portions of a drawing (for example, a floor or specific room), take the coordinates from the CAD package and enter these coordinates into the File Open Dialog box displayed in Figure 8.2-3. The Maximum Horz. and Maximum Vert. represent the upper right coordinates of the area the user wants to display. The Minimum Horz. and Minimum Vert. represent the lower left coordinates of the area (refer to Figure 8.2-4).

**Figure 8.2-4 Determining CAD Coordinates**

**NOTE**

The custom label and CAD coordinates must be entered for each screen added.

After entering Custom label and CAD coordinates, press OK. This brings you back to the Select Screen dialog box. The graphic screens display in a treelike fashion in the dialog box. The new screen's custom label should appear on the tree. Highlight the new screen created from WORK.DXF and press OK. This brings the floor plan up on the Graphic Presentation Window. Press the F2 key on your keyboard to create the .BMP file with the same name as the eight-character custom label.

Repeat Step 2 for each screen to be added to the tree in the Select Screen dialog box (all .DXF screens to be viewed must be added in this dialog box). To add a subscreen to the tree, select the screen under which the new screen will be inserted before pressing the Add Screen button. For example, if the office building has 22 floors, the tree view would contain the "office" screen with floor plan screens of each floor under the main office screen. (Refer to Figure 8.2-5)
Step 3 - Creating the Device File

In Step 3, copy the original parent file, PARENT.DXF, to a working file as done in Step 1. Use the same file name as used in Step 1, WORK.DXF. After copying the file, use the CAD program to remove all background entities from WORK.DXF. When finished, WORK.DXF should only display the devices. The background is stored in CUSTOM LABEL.BMP created in Step 2 and should not be in the new working .DXF file. Make sure that the device file created in this step is always named with the same name as it's corresponding background file created in Step 1.

After changing or inputting system screens, exit and restart the NRT application to ensure proper operation. From the main NRT window, select Graphic Presentation under the Window menu. Select Screen under the Select menu. This will bring up the Select Screen dialog box with the new screens. Select a screen and press OK. This will bring up a combined screen of the floor plan background bitmap created in Step 2 and the device plan created in Step 3. All devices should now appear as a green triangle/square with the network address.

Select Screen Dialog Box Buttons

The Edit button allows the user to edit the custom label of the screen and the coordinates of the current file.

To delete a screen, select the screen to delete in the Select Screen dialog box. Press the Delete button to delete the screen.

The Cancel button closes the Select Screen dialog box and displays the Screen Display Window.

The Toggle button allows the user expand or collapse the view of the screen tree, showing only the main parent screen or the parent screen and all of its sub screens.

The Scroll Up, Scroll Left, Scroll Right, and Scroll Down buttons move the Select Screen dialog box to access screens not shown.

8.3 CUSTOMIZING THE GRAPHIC ICONS

The NRT has the ability to allow customized icons for a group of devices. A text file, property.dat, must reside in the NRT directory. The following is an example of a property.dat file, which shows the exact layout necessary for the devices to be associated with bitmap groups.

NOTE
The full path must be given for each bitmap state.
normal = c:\bitmaps\smoke2.bmp,
alarm = c:\bitmaps\smoke3.bmp,
aalarm = c:\bitmaps\smoke3a.bmp,
trouble = c:\bitmaps\smoke4.bmp,
atrouble = c:\bitmaps\smoke4a.bmp,
security = c:\bitmaps\smoke5.bmp,
asecurity = c:\bitmaps\smoke5a.bmp,

address = N1L1D1,
address = N1L1D2,
address = N1L1D3,
address = N1L1D4;

normal = c:\bitmaps\smoke12.bmp,
alarm = c:\bitmaps\smoke13.bmp,
aalarm = c:\bitmaps\smoke13a.bmp,
trouble = c:\bitmaps\smoke14.bmp,
atrouble = c:\bitmaps\smoke14a.bmp,
security = c:\bitmaps\smoke15.bmp,
asecurity = c:\bitmaps\smoke15a.bmp,

address = N1L1D11,
address = N1L1D12,
address = N1L1D13,
address = N1L1D14;

normal = c:\bitmaps\pull1.bmp,
alarm = c:\bitmaps\pull2.bmp,
aalarm = c:\bitmaps\pull2a.bmp,
trouble = c:\bitmaps\pull3.bmp,
atrouble = c:\bitmaps\pull3a.bmp,
security = c:\bitmaps\pull4.bmp,
asecurity = c:\bitmaps\pull4a.bmp,

address = N1L1M1,
address = N1L1M2,
address = N1L1M3,
address = N1L1M4;

In the above example, a group of seven bitmap states are listed with the literal path to the bitmap file first, followed by a blank line. All the devices which use the group bitmaps are listed. The last device listed for a bitmap group MUST have a semi-colon (;) at the end of the line. This separates one bitmap grouping from another. All other lines should end in a comma.

As in the above example, another group can be added (bitmaps and then devices) after the semi-colon which ends a previous group. The end of the file is marked by the last semi-colon of the last device entry; no other special characters are needed.
### 8.4 SETTING UP THE ZOOM FEATURE

The NRT will allow a zoom feature if so defined. This feature is designed to give a more detailed view of a device and the surrounding area. The following steps must be taken to correctly set up the zoom feature.

1. Define a parent screen that contains a device or set of devices.
2. Add a sub-screen to the parent screen. The same device or devices must be defined on the sub-screen.

When a signal is received, the device on the parent screen will be displayed. The zoom-in feature then will find the same device on the sub-screen. If more sub-screens are defined with the same device(s) on all, subsequent zoom-in commands will vector to the next level.

### 8.5 AUTOMATIC SCREEN VECTORING

The NRT graphics system automatically changes the displayed screen to show the highest priority event. This function is called "Automatic Screen Vectoring" or "Screen Vectoring."

Screen vectoring uses the same event priority algorithms as the System Interface Window. The user can still manually change screens using the Select Screen dialog box.

**NOTE**

*Automatic screen vectoring is only enabled if the NRT is in the Graphic Presentation window.*
CHAPTER THREE

OPERATION
SECTION ONE NORMAL OPERATION

During normal operation, when no fire alarms or troubles exist, the command center and user-defined system will appear as shown below with an "All Systems Normal" message in each alarm and trouble window.

The user can perform functions associated with the following buttons without having to enter a password:

ACK The Ack (acknowledge) button acknowledges events currently in the system. Alarms are acknowledged individually, and troubles are acknowledged as a group (block acknowledge). Receiving unit mode is not supported on the NRT and all nodes on the network should be configured for block acknowledge.

SIG SIL The Sig Sil (signal silence) button silences all control modules in the system that are programmed as silenceable. The System Interface Window will reflect that a signal silence is requested.

RESET The reset button resets all fire panels for the particular system in which it was requested.
SECTION TWO FIRE ALARMS

2.1 FIRE ALARMS

Figure 2.1-1 illustrates the format displayed when a fire alarm condition occurs:

![Figure 2.1-1 Fire Alarm Messages in the System Interface Window](image)

- **Device Status**: The status of the module or detector which has gone into alarm.
- **Device Type**: Refer to the AM2020/AFP1010 Manual (Document 15088), the AFP200 Manual (Document 15511) or the AFP-300/AFP-400 Programming Manual (Document 50259) for information on Device Types.
- **Custom Device Label**: The user-entered label that was entered during programming.
- **Software Zone Label**: The first software zone that the device was mapped to during programming.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Device Address**: The location of the device in alarm. Format: Node (N) XXX, LIB (L) XX, Detector (D) or Module (M) XX.

**NOTE:**

*If an NRT/INA is powered down while alarms or troubles are generated on the network, it is possible for these signals to be delayed for up to one minute before reporting on the remaining NRTs/INAs on the network.*

2.2 ACKNOWLEDGING ONE OR MORE FIRE ALARMS

To acknowledge fire alarm conditions, press the ACK button in the System Interface Window. After the ACK button has been pressed, an ACK AL SMOKE (PHOTO) message displays in the Alarm window (refer to Figure 2.2-1). There is a three-second delay between the time the ACK button is pressed and the ACK ALARM message is displayed. Continue pressing the ACK button until each alarm has been acknowledged individually. The alarm banner and alarm tone will remain active until all alarms have been acknowledged.
When multiple events occur, the system displays the first alarm and the first trouble that occurred in their respective windows. In the trouble window, higher priority troubles overwrite lower priority troubles. To acknowledge events currently in the system, press the ACK button.
SECTION THREE TROUBLES

When the trouble condition is cleared by Systems Reset, the Trouble window displays a Network System Reset followed by an All Systems Normal message.

When multiple events occur, the system displays the first alarm and the first trouble that occurred in their respective windows. In the trouble window, higher priority troubles overwrite lower priority troubles. To acknowledge current events in the system, press the ACK button.

3.1 TROUBLES WITH ADDRESSABLE DEVICES

Figure 3.1-1 illustrates an Addressable Device trouble condition.

<table>
<thead>
<tr>
<th>Device Status</th>
<th>Device Type</th>
<th>Custom Device Label</th>
<th>Software Zone</th>
<th>Type of Trouble</th>
<th>Time/Date</th>
<th>Device Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>TROUBL</td>
<td>SMOKE(PHOTO)</td>
<td>COMPUTER ROOM</td>
<td>Z001</td>
<td>INVALID REPLY</td>
<td>3:48 03/01/93</td>
<td>N1L1D1</td>
</tr>
</tbody>
</table>

**Figure 3.1-1  Addressable Device Trouble Condition**

Device Status: The status of the module or detector which has gone into trouble.

Device Type: Refer to the AM2020/AFP1010 Manual (Document 15088), the AFP-200 Manual (Document 15511) or the AFP-300/AFP-400 Programming Manual (Document 50259) for information on Device Types.

Custom Device Label: The user-entered label that was entered during programming.

Software Zone: The first software zone that the device was mapped to during programming.

Type of Trouble: Refer to the AM2020/AFP1010 Manual (Document 15088), the AFP-200 Manual (Document 15511) or the AFP-300/AFP-400 Programming Manual (Document 50259) for information on Trouble Types.

Time/Date: Hour:Minute Month/Day/Year.

Device Address: The location of the device in trouble. Format: Node (N) XXX, LIB (L) XX, Detector (D) or Module (M) XX.
## 3.2 TROUGLES WITH SECURITY DEVICES

Figure 3.2-1 illustrates a security device trouble condition.

<table>
<thead>
<tr>
<th>Device Status</th>
<th>Device Type</th>
<th>Custom Device Label</th>
<th>Software Zone</th>
<th>Type of Trouble</th>
<th>Time/Date</th>
<th>Device Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>TROUBL</td>
<td>AREA MONITOR</td>
<td>COMPUTER ROOM</td>
<td>ZO87</td>
<td>SECURITY ALARM</td>
<td>11:32 03/01/93</td>
<td>N1L2M4</td>
</tr>
</tbody>
</table>

**Figure 3.2-1 Security Device Trouble Condition**

- **Device Status**: The status of the module which has gone into trouble.
- **Device Type**: Refer to the AM2020/AFP1010 Manual (Document 15088), the AFP-200 Manual (Document 15511) or the AFP-300/AFP-400 Programming Manual (Document 50259) for information on Device Types.
- **Custom Device Label**: The user-entered label that was entered during programming.
- **Software Zone**: The first software zone that the device was mapped to during programming.
- **Type of Trouble**: Refer to the AM2020/AFP1010 Manual (Document 15088), the AFP-200 Manual (Document 15511) or the AFP-300/AFP-400 Programming Manual (Document 50259) for information on Trouble Types.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Device Address**: The location of the device in trouble. Format: Node (N) XXX, LIB (L) XX, Module (M) XX.
### 3.3 TROUBLES WITH SUPERVISORY DEVICES

Figure 3.3-1 illustrates a supervisory device trouble condition.

<table>
<thead>
<tr>
<th>Device Status</th>
<th>Device Type</th>
<th>Custom Device Label</th>
<th>Software Zone</th>
<th>Type of Trouble</th>
<th>Time/Date</th>
<th>Device Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>TROUBL</td>
<td>SPRNKLR MNTR COMPUTER ROOM</td>
<td>ZO87 SPRINKLER TROUBLE</td>
<td>11:32 03/01/93</td>
<td>N1L2M4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 3.3-1 Supervisory Device Trouble Condition**

- **Device Status**: The status of the module which has gone into trouble.
- **Device Type**: Refer to the AM2020/AFP1010 Manual (Document 15088), the AFP-200 Manual (Document 15511) or the AFP-300/AFP-400 Programming Manual (Document 50259) for information on Device Types.
- **Custom Device Label**: The user-entered label that was entered during programming.
- **Software Zone**: The first software zone that the device was mapped to during programming.
- **Type of Trouble**: Refer to the AM2020/AFP1010 Manual (Document 15088), the AFP-200 Manual (Document 15511) or the AFP-300/AFP-400 Programming Manual (Document 50259) for information on Trouble Types.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Device Address**: The location of the device in trouble. Format: Node (N) XXX, LIB (L) XX, Module (M) XX.
3.4 TROUBLES WITH DISABLED ZONES

Figure 3.4-1 illustrates a disabled zone trouble condition.

<table>
<thead>
<tr>
<th>Zone Status</th>
<th>Zone Type</th>
<th>Custom Zone Label</th>
<th>Type of Trouble (Fixed)</th>
<th>Time/Date</th>
<th>Zone Address</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FORWARD ZONE</td>
<td>COMPUTER ROOM</td>
<td>DISABLED</td>
<td>11:32 03/01/93</td>
<td>N1Z237</td>
</tr>
</tbody>
</table>

**Figure 3.4-1 Disabled Zone Trouble Condition**

- **Zone Status**: The status of the AM2020/AFP1010 or AFP-200 zone on a NOTI•FIRE•NET node.
- **Zone Type**: Forward Zone or Reverse Zone.
- **Custom Zone Label**: The user-entered label that was entered during programming.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Zone Address**: The location of the disabled zone in the form: Node (N) XXX, Zone (Z) XXX.

3.5 TROUBLES WITH AM2020/AFP1010 SYSTEMS

Figure 3.5-1 illustrates a trouble condition with an AM2020/AFP1010 node. For an explanation of some trouble messages, refer to the AM2020/AFP1010 Manual (Document 15088).

<table>
<thead>
<tr>
<th>System Status</th>
<th>Specific Trouble Message</th>
<th>Time/Date</th>
<th>Trouble Index</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CATASTROPHIC LOOP</td>
<td>15:12 03/01/93</td>
<td>N1T19</td>
</tr>
</tbody>
</table>

**Figure 3.5-1 AM2020/AFP1010 System Trouble Condition**

- **System Status**: The status of the AM2020/AFP1010 node which has gone into trouble.
- **Specific Trouble Message**: Any AM2020/AFP1010 System Trouble Message.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Trouble Index**: The location of the system in trouble in the form: Node (N) XXX, Trouble Index (T) XX. Provide this index to a Notifier Representative for troubleshooting.
3.6 TROUBLES WITH ANNUNCIATORS

Figure 3.6-1 illustrates a trouble condition with an annunciator module within a network node. For an explanation of some trouble messages, refer to the AM2020/AFP1010 Manual (Document 15088) or the AFP200 Manual (Document 15511).

**Figure 3.6-1 Annunciator Trouble Condition**

- **Annunciator Status**: The status of an annunciator module connected to an AM2020/AFP1010 or AFP200.
- **Annunciator Module**: The annunciator address.
- **Specific Trouble Message**: Any AM2020/AFP1010 or AFP200 Annunciator Trouble Message.
- **Custom Annunciator Label**: The user-entered label that was entered during programming.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Trouble Index**: The location of the annunciator trouble in the form: Node (N) XXX, Trouble Index (N) XX. Provide this index to a Notifier Representative for troubleshooting.

3.7 TROUBLES WITH AFP-300/AFP-400 BELL CIRCUITS

Figure 3.7-1 illustrates a trouble condition with an AFP-300/AFP-400 Bell Circuit within a network node. For an explanation of some trouble messages, refer to the AFP-300/AFP-400 Installation Manual (Document 50253).

**Figure 3.7-1 AFP-300/AFP-400 Bell Circuit Trouble Condition**

- **Bell Circuit Status**: The status of a AFP-300/AFP-400 bell circuit.
- **Bell Circuit Module**: Refer to the AFP-300/AFP-400 Installation Manual for information on Bell Circuit modules.
- **Custom Label**: The user-entered label that was entered during programming.
- **Type of Trouble**: Refer to the AFP-300/AFP-400 Installation Manual for information on trouble types.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Bell Circuit Address**: The location of the bell circuit in trouble. Format Node (N) XXX, Bell (B) Y.
**3.8 TROUBLES WITH AFP-400 PANEL CIRCUITS**

Figure 3.8-1 illustrates a trouble condition with an AFP-300/AFP-400 Panel Circuit within a network node. For an explanation of some trouble messages, refer to the AFP-300/AFP-400 Installation Manual (Document 50253).

<table>
<thead>
<tr>
<th>New Troubles: 00001</th>
<th>Total Troubles: 00001</th>
</tr>
</thead>
<tbody>
<tr>
<td>TROUBL CONTROL</td>
<td>PANEL CIRCUIT NO. 2</td>
</tr>
</tbody>
</table>

**Figure 3.8-1  AFP-300/AFP-400 Panel Circuit Trouble Condition**

- **Bell Circuit Status**: The status of a AFP-300/AFP-400 panel circuit.
- **Bell Circuit Module**: Refer to the AFP-300/AFP-400 Installation Manual for information on Bell Circuit modules.
- **Custom Label**: The user-entered label that was entered during programming.
- **Type of Trouble**: Refer to the AFP-300/AFP-400 Installation Manual for information on trouble types.
- **Time/Date**: Hour:Minute Month/Day/Year.
- **Bell Circuit Address**: The location of the panel circuit in trouble. Format Node (N) XXX, Panel (P) Y, Circuit (C) Z.
3.9 ACKNOWLEDGING TROUBLES

To acknowledge a trouble condition, press the ACK button in the System Interface Window. The trouble window for the Command Center reflects that the trouble is acknowledged (refer to Figure 3.9-1).

Figure 3.9-1 Acknowledging Trouble Conditions

3.9.1 TROUBLE WITH NRT AND INA EQUIPMENT

Signals originating at the NRT and INA are transmitted to other reporting nodes (i.e., NRT or another INA) on the network. All local troubles are reported with the exception of node off-line conditions which depend on the local settings of the NRT or INA and are reported individually by all reporting nodes.

Below is a list of trouble messages which are exclusive to the NOTI•FIRE•NET network environment.

- **Node XXX Communications Failure**
  The node is programmed into the system but does not exist physically on the network, or the node is physically attached to the network but is not programmed into the Command Center.

- **Communication Link Failure in Port A**
  Data is not being received on network (MIB) Port A. This trouble is only reported if the node is configured for dual port supervision.

- **Communication Link Failure in Port B**
  Data is not being received on network (MIB) Port B. This trouble is only reported if the node is configured for dual port supervision.

- **Lan Communications Failure**
  The specific network node can no longer communicate with the rest of the network, indicating a problem with the network connections. This message also appears if the node’s address has been set to “0.”

- **NRT Fan Failure**
  The PC Fan has stopped working.

- **NRT UPS Failure**
  A problem has been detected with the UPS.

3.9.2 AFP300/AFP-400 and AFP-200 Device Message Translations

Other trouble messages are documented in the AM2020/AFP1010 Manual (Document 15088), the AFP-200 Manual (Document 15511) and the AFP-300/AFP-400 Operations Manual (Document 50260). Some messages differ between the AFP-200, AFP-300/AFP-400 and the INA and NRT. Tables 3.9.1-1 and 3.9.1-2 depict AFP-200 and AFP-300/AFP-400 messages as they appear on the INA and NRT. If the system displays a message that is not self-explanatory and is not listed in this section, contact a Notifier Representative. For more information on INAs and their troubles, refer to the INA manual.

Messages for system troubles are the same between the AFP-200, AFP-300/AFP-400 and the INA and NRT.
<table>
<thead>
<tr>
<th>Type I.D.</th>
<th>AFP-200 Message</th>
<th>INA LCD Message</th>
<th>NRT Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisory</td>
<td>activated: ACTIVE SUPERVISING custom point label ZONE 04 01:40P 10/26/95 M04</td>
<td>activated: TROUBL N012 SPSU custom point label Z004 SPRINKLR TROUBLE 01:51P 10/26/95 104</td>
<td>activated: TROUBL SPSU MONITOR custom point label Z4 SPRINKLR TROUBLE 13:49 10/26/95 N12LIM4</td>
</tr>
<tr>
<td>Tamper</td>
<td>activated: ACTIVE TAMPER custom point label Z004 OPEN CIRCUIT 02:43P 10/26/95 M05</td>
<td>activated: TROUBL N012 SPSU custom point label Z004 OPEN CIRCUIT 02:43P 10/26/95 105</td>
<td>activated: TROUBL SPSU MONITOR custom point label Z4 OPEN CIRCUIT 14:41 10/26/95 N12LIM5</td>
</tr>
<tr>
<td>Non-Fire</td>
<td>activated: ACTIVE NONFIRE custom point label Z04 OPEN CIRCUIT 02:21P 11/07/95 M06</td>
<td>activated: ACTIVE N012 NOA custom point label ZONE 04 01:12P 11/07/95 016</td>
<td>activated: *ACTIVE NON ALARM custom point label Z4 13:10 11/07/95 N12LIM6</td>
</tr>
<tr>
<td>Fire Control</td>
<td>activated: ACTIVE FIRE CONTROL custom point label Z04 OPEN CIRCUIT 03:35P 11/07/95 M08</td>
<td>activated: ACTIVE N012 NONA custom point label ZONE 04 02:26P 11/07/95 108</td>
<td>activated: *ACTIVE NON ALARM custom point label Z4 14:23 11/07/95 N12LIM8</td>
</tr>
<tr>
<td></td>
<td>*Will only print out in ACTIVE HISTORY BUFFER portion of NRT.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 3.9.1-1 AFP-200 Device Messages as They Appear on the INA and NRT (page 2 of 2)

<table>
<thead>
<tr>
<th>AFP-300/ AFP-400 Type I.D.</th>
<th>AFP-300/AFP-400 Message</th>
<th>INA LCD Message</th>
<th>NRT Message</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Smoke Detect</strong></td>
<td>alarm (short): ALARM: SMOKE DETECT device label zone label 01:27p 05/07/97 M121</td>
<td>alarm (short): ALARM N232 M3MK device label zone label 01:27p 05/07/97 121</td>
<td>alarm (short): ALARM: SMOKE DETECT device label zone label 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE SMOKE DETECT device label Z05 INVALID REPLY 01:27p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 M3MK device label Z05 INVALID REPLY 01:27p 05/07/97 121</td>
<td>trouble: TROUBLE SMOKE DETECT device label Z5 INVALID REPLY 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Heat Detect</strong></td>
<td>alarm (short): ALARM: HEAT DETECT device label zone label 01:27p 05/07/97 M121</td>
<td>alarm (short): ALARM: N232 MHT device label zone label 01:27p 05/07/97 121</td>
<td>alarm (short): ALARM: HEAT DETECT device label zone label 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE HEAT DETECT device label Z05 INVALID REPLY 01:27p 05/07/97 M121</td>
<td>trouble: TROUBLE: TROUBL N232 MHT device label Z05 INVALID REPLY 01:27p 05/07/97 121</td>
<td>trouble: TROUBL HEAT DETECT device label Z5 INVALID REPLY 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Pull Station</strong></td>
<td>alarm (short): ALARM: PULL STATION device label zone label 01:27p 05/07/97 M121</td>
<td>alarm (short): ALARM: N232 PULL device label zone label 01:27p 05/07/97 121</td>
<td>alarm (short): ALARM: PULL STATION device label zone label 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL PULL STATION device label Z05 INVALID REPLY 01:27p 05/07/97 M121</td>
<td>trouble: TROUBL N232 PULL device label Z05 INVALID REPLY 01:27p 05/07/97 121</td>
<td>trouble: TROUBL PULL STATION device label Z5 INVALID REPLY 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Monitor</strong></td>
<td>alarm (short): ALARM: MONITOR device label zone label 01:27p 05/07/97 M121</td>
<td>alarm (short): ALARM: N232 MON device label zone label 01:27p 05/07/97 121</td>
<td>alarm (short): ALARM: MONITOR device label zone label 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL MONITOR device label Z05 INVALID REPLY 01:27p 05/07/97 M121</td>
<td>trouble: TROUBL N232 MON device label Z05 INVALID REPLY 01:27p 05/07/97 121</td>
<td>trouble: TROUBL MONITOR device label Z5 INVALID REPLY 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>(blank)</strong></td>
<td>alarm (short): ALARM: device label zone label 01:27p 05/07/97 M121</td>
<td>alarm (short): ALARM: N232 device label zone label 01:27p 05/07/97 121</td>
<td>alarm (short): ALARM: device label zone label 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL device label Z05 INVALID REPLY 01:27p 05/07/97 M121</td>
<td>trouble: TROUBL N232 device label Z05 INVALID REPLY 01:27p 05/07/97 121</td>
<td>trouble: TROUBL device label Z5 INVALID REPLY 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Abort Switch</strong></td>
<td>alarm (short): ACTIVE ABORT SWITCH device label zone label 01:27p 05/07/97 M121</td>
<td>alarm (short): ACTIVE N22 absw device label zone label 01:27p 05/07/97 121</td>
<td>alarm short: ACTIVE ABORT SWITCH device label zone label 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL ABORT SWITCH device label Z05 INVALID REPLY 01:27p 05/07/97 M121</td>
<td>trouble: TROUBL N232 absw device label Z05 INVALID REPLY 01:27p 05/07/97 121</td>
<td>trouble: TROUBL ABORT SWITCH device label Z5 INVALID REPLY 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Man. Release</strong></td>
<td>alarm (short): ALARM: MAN. RELEASE device label zone label 01:27p 05/07/97 M121</td>
<td>alarm (short): ALARM: N232 MANR device label zone label 01:27p 05/07/97 121</td>
<td>alarm (short): ALARM: MAN. RELEASE device label zone label 01:27p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL MAN. RELEASE device label Z05 INVALID REPLY 01:27p 05/07/97 M121</td>
<td>trouble: TROUBL N232 MANR device label Z05 INVALID REPLY 01:27p 05/07/97 121</td>
<td>trouble: TROUBL MAN. RELEASE device label Z5 INVALID REPLY 01:27p 05/07/97 N232L1M21</td>
</tr>
</tbody>
</table>

Table 3.9.1-2 AFP300/AFP-400 Device Messages as They Appear on the INA and NRT (page 1 of 5)
<table>
<thead>
<tr>
<th>Message Type</th>
<th>AFP-300/AFP-400 Message</th>
<th>INA LCD Message</th>
<th>NRT Message</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Silence</strong></td>
<td>alarm (short): ACTIVE SILENCE device label zone label 12:40p 05/07/97 M121</td>
<td>alarm (short): ACTIVE N232 SL device label zone label 12:40p 05/07/97 121</td>
<td>alarm (short): ACTIVE SILENCE device label zone label 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE SILENCE device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 SL device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TROUBLE SILENCE device label Z05 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>System Reset</strong></td>
<td>alarm (short): ACTIVE SYSTEM RESET device label zone label 12:40p 05/07/97 M121</td>
<td>alarm (short): ACTIVE N232 SRST device label zone label 12:40p 05/07/97 121</td>
<td>alarm (short): ACTIVE SYSTEM RESET device label zone label 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE SYSTEM RESET device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 SRST device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TROUBLE SYSTEM RESET device label Z05 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>alarm (short and open): ACTIVE SECURITY device label zone label 12:40p 05/07/97 M121</td>
<td>alarm (short and open): TROUBLE N232 SECU device label zone label 05 SECURITY ALARM 12:40p 05/07/97 121</td>
<td>alarm (short and open): TROUBLE SECURITY device label Z5 SECURITY ALARM 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE SECURITY device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 SECU device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TROUBLE SECURITY device label Z5 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Trouble MON</strong></td>
<td>alarm (short): TROUBLE MON device label Z05 SHORT CIRCUIT 12:40p 05/07/97 M121</td>
<td>alarm (short): TROUBLE N232 MTRB device label Z05 SHORT CIRCUIT 12:40p 05/07/97 121</td>
<td>alarm (short): TROUBLE MON device label Z5 SHORT CIRCUIT 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE MON device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 MTRB device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TROUBLE MON device label Z5 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>PAS Inhibit</strong></td>
<td>alarm (short): ACTIVE PAS INHIBIT device label zone label 12:40p 05/07/97 M121</td>
<td>alarm (short): ACTIVE N232 PASI device label zone label 12:40p 05/07/97 121</td>
<td>alarm (short): ACTIVE PAS INHIBIT device label zone label 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE PAS INHIBIT device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 PASI device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TROUBLE PAS INHIBIT device label Z5 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>AllCall Page</strong></td>
<td>alarm (short): ACTIVE ALLCALL PAGE device label zone label 12:40p 05/07/97 M121</td>
<td>alarm (short): ACTIVE N232 ALPG device label zone label 12:40p 05/07/97 121</td>
<td>alarm (short): ACTIVE ALLCALL PAGE device label zone label 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE ALLCALL PAGE device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 ALPG device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TROUBLE ALLCALL PAGE device label Z5 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Tamper</strong></td>
<td>alarm (short): ACTIVE TAMPER device label zone label 12:40p 05/07/97 M121</td>
<td>alarm (short): TROUBLE N232 TAMPER device label zone label 12:40p 05/07/97 121</td>
<td>alarm (short): TROUBLE TAMPER device label zone label 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE TAMPER device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 TAMPER device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TAMPER device label Z05 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td><strong>Fire Control</strong></td>
<td>alarm (short): ACTIVE FIRE CONTROL device label zone label 12:40p 05/07/97 M121</td>
<td>alarm (short): ACTIVE N232 FCON device label zone label 12:40p 05/07/97 121</td>
<td>alarm (short): ACTIVE FIRE CONTROL device label zone label 12:40p 05/07/97 N232L1M21</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBLE FIRE CONTROL device label Z05 INVALID REPLY 12:40p 05/07/97 M121</td>
<td>trouble: TROUBLE N232 FCON device label Z05 INVALID REPLY 12:40p 05/07/97 121</td>
<td>trouble: TROUBLE FIRE CONTROL device label Z05 INVALID REPLY 12:40p 05/07/97 N232L1M21</td>
</tr>
</tbody>
</table>

Table 3.9.1-2 AFP-300/AFP-400 Messages as They Appear on the INA and NRT (page 2 of 5)
<table>
<thead>
<tr>
<th>Tele. Page</th>
<th>AFP-300/ AFP-400 Type ID.</th>
<th>AFP-300/ AFP-400 Message</th>
<th>INA LCD Message</th>
<th>NRT Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarm (short): ACTIVE TELE. PAGE device label zone label 03:15P 05/07/97 M121</td>
<td>alarm (short): ACTIVE TELE. PAGE device label zone label 03:15P 05/07/97 M121</td>
<td>alarm (short): ACTIVE TELE. PAGE device label zone label 3:15P 05/07/97 121</td>
<td>alarm (short): ACTIVE TELE. PAGE device label zone label 3:15P 05/07/97 N232LM21</td>
<td></td>
</tr>
<tr>
<td>trouble: TROUBL TELE. PAGE device label Z05 INVALID REPLY 3:15P 05/07/97 M121</td>
<td>trouble: TROUBL TELE. PAGE device label Z05 INVALID REPLY 3:15P 05/07/97 M121</td>
<td>trouble: TROUBL TELE. PAGE device label Z05 INVALID REPLY 3:15P 05/07/97 N232LM21</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Comb. Monitor | | | | |
| alarm (short): ALARM: COMB. MONITOR device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: COMB. MONITOR device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: COMB MONITOR device label zone label 3:15P 05/07/97 N232LM21 |
| trouble: TROUBL COMB. MONITOR device label Z05 INVALID REPLY 3:15P 05/07/97 M121 | trouble: TROUBL COMB. MONITOR device label Z05 INVALID REPLY 3:15P 05/07/97 M121 |

| Sprinkler Sys | | | | |
| alarm (short): ALARM: SPRINKLER SYS device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: SPRINKLER SYS device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: SPRINKLER SYS device label zone label 3:15P 05/07/97 N232LM21 |
| trouble: TROUBL SPRINKLER SYS device label Z05 INVALID REPLY 3:15P 05/07/97 M121 | trouble: TROUBL SPRINKLER SYS device label Z05 INVALID REPLY 3:15P 05/07/97 M121 |

| Second Shot | | | | |
| alarm (short): ACTIVE SECOND SHOT device label zone label 3:15P 05/07/97 M121 | alarm (short): ACTIVE SECOND SHOT device label zone label 3:15P 05/07/97 M121 | alarm (short): ACTIVE SECOND SHOT device label zone label 3:15P 05/07/97 N232LM21 |
| trouble: TROUBL SECOND SHOT device label Z05 INVALID REPLY 3:15P 05/07/97 M121 | trouble: TROUBL SECOND SHOT device label Z05 INVALID REPLY 3:15P 05/07/97 M121 |

| Man Rel Day | | | | |
| alarm (short): ALARM: MAN REL DLAY device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: MAN REL DLAY device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: MAN REL DLAY device label zone label 3:15P 05/07/97 N232LM21 |
| trouble: TROUBL MAN REL DLAY device label Z05 INVALID REPLY 3:15P 05/07/97 M121 | trouble: TROUBL MAN REL DLAY device label Z05 INVALID REPLY 3:15P 05/07/97 M121 |

| Hazard Alert | | | | |
| alarm (short): ACTIVE HAZARD ALERT device label zone label 3:15P 05/07/97 M121 | alarm (short): ACTIVE HAZARD ALERT device label zone label 3:15P 05/07/97 M121 | alarm (short): ACTIVE HAZARD ALERT device label zone label 3:15P 05/07/97 N232LM21 |
| trouble: TROUBL HAZARD ALERT device label Z05 INVALID REPLY 3:15P 05/07/97 M121 | trouble: TROUBL HAZARD ALERT device label Z05 INVALID REPLY 3:15P 05/07/97 M121 |

| Supervisory | | | | |
| alarm (short): ACTIVE SUPERVISORY device label zone label 3:15P 05/07/97 M121 | alarm (short): ACTIVE SUPERVISORY device label zone label 3:15P 05/07/97 M121 | alarm (short): ACTIVE SUPERVISORY device label zone label 3:15P 05/07/97 N232LM21 |
| trouble: TROUBL SUPERVISORY device label Z05 INVALID REPLY 3:15P 05/07/97 M121 | trouble: TROUBL SUPERVISORY device label Z05 INVALID REPLY 3:15P 05/07/97 M121 |

| Waterflow | | | | |
| alarm (short): ALARM: WATERFLOW device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: WATERFLOW device label zone label 3:15P 05/07/97 M121 | alarm (short): ALARM: WATERFLOW device label zone label 3:15P 05/07/97 N232LM21 |
| trouble: TROUBL WATERFLOW device label Z05 INVALID REPLY 3:15P 05/07/97 M121 | trouble: TROUBL WATERFLOW device label Z05 INVALID REPLY 3:15P 05/07/97 M121 |

Table 3.9.1-2 AFP-300/AFP-400 Device Messages as they Appear on the INA and NRT (page 3 of 5)
<table>
<thead>
<tr>
<th>Device Type</th>
<th>Message Type</th>
<th>INA LCD Message</th>
<th>NRT Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 FP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL CONTROL</td>
<td>trouble: TROUBL CONTROL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>device label Z05</td>
<td>device label Z05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td>Relay</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL RELAY</td>
<td>trouble: TROUBL RELAY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>device label Z05</td>
<td>device label Z05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td>Bell Circuit</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 FP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL BELL</td>
<td>trouble: TROUBL BELL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIRCUIT device label Z05</td>
<td>CIRCUIT device label Z05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td>Strobe Ckt</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 FP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL STROBE</td>
<td>trouble: TROUBL STROBE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CKT device label Z05</td>
<td>CKT device label Z05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td>Horn Circuit</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 FP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL HORN</td>
<td>trouble: TROUBL HORN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIRCUIT device label Z05</td>
<td>CIRCUIT device label Z05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td>Audible Ckt</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 FP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL AUDIBLE</td>
<td>trouble: TROUBL AUDIBLE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CKT device label Z05</td>
<td>CKT device label Z05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td>Rel End Bell</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 FP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL REL END</td>
<td>trouble: TROUBL REL END</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BELL device label ZR1</td>
<td>BELL device label ZR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td>Release Ckt</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 FP400</td>
<td>on: ACTIVE AFP400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OUTPUT DEVICE 12:07P</td>
<td>OUTPUT DEVICE 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trouble: TROUBL RELEASE</td>
<td>trouble: TROUBL RELEASE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CKT device label ZR1</td>
<td>CKT device label ZR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INVALID REPLY 12:07P</td>
<td>INVALID REPLY 12:07P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5/16/97 101</td>
<td>5/16/97 N232L1M1</td>
</tr>
</tbody>
</table>

*All AFP300/AFP-400 messages that say 'No Annunciation' will be displayed in the History Buffer, only.
<table>
<thead>
<tr>
<th>AFP-300/ AFP-400 Type I.D.</th>
<th>AFP-300/ AFP-400 Message</th>
<th>INA LCD Message</th>
<th>NRT Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rel Ckt Ulc</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL REL CKT ULC device label ZR1 INVALID REPLY 04:55P 05/16/97 M101</td>
<td>trouble: TROUBL N232 RULC device label Z INVALID REPLY 04:55P 05/16/97 101</td>
<td>trouble: TROUBL REL CKT ULC device label Z INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td>Rel Audible</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL REL AUDIBLE device label ZR1 INVALID REPLY 04:55P 05/16/97 M101</td>
<td>trouble: TROUBL N232 RAUD device label Z INVALID REPLY 04:55P 05/16/97 101</td>
<td>trouble: TROUBL REL AUDIBLE device label Z INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td>Nonreset Stl</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL NONRESET CTL device label Z05 INVALID REPLY 04:55P 05/16/97 M101</td>
<td>trouble: TROUBL N232 NONR device label Z05 INVALID REPLY 04:55P 05/16/97 101</td>
<td>trouble: TROUBL NONRESET CTL device label Z5 INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td>Telephone</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL TELEPHONE device label Z05 INVALID REPLY 04:55P 05/16/97 M101</td>
<td>trouble: TROUBL N232 TELE device label Z005 INVALID REPLY 04:55P 05/16/97 101</td>
<td>trouble: TROUBL TELEPHONE device label Z5 INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td>Rel Code Bell</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL REL CODE BELL device label ZR1</td>
<td>trouble: TROUBL N232 RCBL device label ZR01 INVALID REPLY 04:55P 05/16/97 B01</td>
<td>trouble: TROUBL REL CODE BELL device label ZR1 INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td>Instant Rele</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL INSTANT RELE device label Z05 INVALID REPLY 04:55P 05/16/97 M101</td>
<td>trouble: TROUBL N232 IREL device label Z005 INVALID REPLY 04:55P 05/16/97 101</td>
<td>trouble: INSTANT RELE device label Z5 INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td>Relea Form C</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL RELEA FORM C device label Z R1 INVALID REPLY 04:55P 05/16/97 M101</td>
<td>trouble: TROUBL N232 RFMC device label ZR01 INVALID REPLY 04:55P 05/16/97 101</td>
<td>trouble: TROUBL RELEA FORM C device label ZR1 INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td>Speaker</td>
<td>on: No Annunciation*</td>
<td>on: ACTIVE N232 AFP400 OUTPUT DEVICE 04:55P 05/16/97 101</td>
<td>on: ACTIVE AFP400 OUTPUT DEVICE 04:55P 05/16/97 N2321M1</td>
</tr>
<tr>
<td></td>
<td>trouble: TROUBL SPEAKER device label Z05 INVALID REPLY 04:55P 05/16/97 M101</td>
<td>trouble: TROUBL N232 SPKR device label Z005 INVALID REPLY 04:55P 05/16/97 101</td>
<td>trouble: TROUBL SPEAKER device label Z05 INVALID REPLY 04:55P 05/16/97 N2321M1</td>
</tr>
</tbody>
</table>

*Any AFP-300/AFP-400 messages that say 'No Annunciation' will be displayed in the History Buffer, only.

Table 3.9.1-2  AFP-300/AFP-400 Device Messages as They Appear on the INA and NRT (page 5 of 5)
SECTION FOUR READ STATUS

The Read Status feature of the NRT allows the operator to display the status of nodes or devices communicating on and programmed into the NOTI•FIRE•NET. Only AM2020/AFP1010 devices are supported for read status operations in this software release.

Detectors

To perform Read Status on a detector in the system, select the node the detector is connected to from the Select System dialog box. Press OK. A node dialog box appears. Press the Sensor button. Enter the address of the detector that is desired to perform Read Status. Press OK. The Detector dialog box appears. This dialog box displays the current programming for the detector, the verification counter, percentage of alarm, and whether the detector is in alarm, trouble, or disabled (refer to Figure 4.0-1).

Annunciator Points

To perform Read Status on an annunciator point, press the Annunciator button from the Node dialog box. Enter the address of the point desired to perform Read Status. Press OK. The Annunciator Point dialog box displays. This dialog box shows the type of annunciator point and whether it is in Alarm, Trouble, or Off (refer to Figure 4.0-2).
Control and Monitor Modules

To perform Read Status on a module in the system, select the node the module is connected to from the Select System dialog box. Press OK. A node dialog box will appear. Press the Module button. Enter the address of the module desired to perform Read Status. Press OK. The Module dialog box will appear. This dialog box displays the current programming for the module and whether the module is in alarm, trouble, or disabled (refer to Figures 4.0-3 and 4.0-4).

Figure 4.0-3  Monitor Module Read Status

Figure 4.0-4  Control Module Read Status
AM2020/AFP1010 FACPs
To perform Read Status on the FACP, press the FACP button from the Node dialog box. The FACP dialog box displays Alarm Verification Time, Signal Silence Inhibit Time, Signal Cut-Out Time, AVPS Installed, Zone boundary, miscellaneous FACP, NFPA Listings, LIB SLC loop and battery information (refer to Figure 4.0-5).

![Figure 4.0-5 FACP Read Status](Image)
Zones

To perform Read Status on an AM2020/AFP1010 zone in the system, select the node the zone is connected to from the Select System dialog box. Press OK. A node dialog box appears. Press the Zone button. Enter the zone number desired to perform Read Status. Press OK. The Zone dialog box will appear. This dialog box displays the current programming for the zone and whether the zone is in alarm, trouble, or is disabled (refer to Figure 4.0-6).

These Boxes are Checked if a Zone is in Alarm, Trouble, or Disabled.

Figure 4.0-6 Zone Read Status

Peripherals

To perform Read Status on peripherals connected to the system, press the Peripherals button from the Node dialog box. The Peripherals dialog box will display information on terminals and printers (refer to Figure 4.0-7).

Figure 4.0-7 Peripheral Read Status
SECTION FIVE
THE GRAPHIC PRESENTATION WINDOW

The Graphic Presentation Window allows the user to view floor plans of a building and locate devices in Alarm/Trouble, access information about the device, and perform Read Status.

Fire Alarms and Active Inputs
When a device goes into alarm or becomes activated, the symbol representing the device in the Graphic Presentation Window turns red and flashes. When the alarm is acknowledged, it turns a darker shade of red and stops flashing. When the alarm or activation is cleared, the symbol returns to its original color.

Troubles
When a device goes into trouble, the symbol representing the device in the Graphic Presentation Window turns bright yellow and flashes. When the trouble is acknowledged, the symbol turns a darker shade of yellow and stops flashing. When the trouble is cleared, the symbol returns to its original color.

Security
When a security device goes into trouble, the symbol representing the device in the Graphic Presentation Window turns bright blue and flashes. When the trouble is acknowledged, the symbol turns a darker shade of blue and stops flashing. When the trouble is cleared, the symbol returns to its original color.

NOTE
After a system reset, AFP-200 and AFP-300/AFP-400 FACP's do not send messages over the network to clear alarms and the NRT continues to display any graphic icons mapped to an AFP-200 and AFP-300/AFP-400 in alarm or trouble. When the NRT receives a "System Reset Completed" message from an AFP-200 and AFP-300/AFP-400, it will then return the AFP-200 and AFP-300/AFP-400 active icons to normal.
5.1 ACCESSING INFORMATION ABOUT DEVICES

Using the Graphic Presentation Window, the user may access several screens which provide information about that particular device and the system as a whole.

For information regarding a specific device, position the mouse directly over the device and press the right mouse button.

A pop-up menu will appear (refer to Figure 5.1-1).

The Pop-Up Menu
The pop-up menu displays the system address followed by the five functions listed below:

- Information - displays a text file (user-programmable).
- Picture - displays a graphic file (user-programmable).
- Read Status/Program - accesses the Read Status Program dialog box.
- Zoom In - displays next level screen (if defined).

The Video option under the pop-up menu is not available in this software release.

Scrolling Through Screens
Individual screens can be viewed by pressing the keyboard arrow buttons. The right arrow button can be used to scroll through all graphic screens.
APPENDIX A

WINDOWS NT® SECURITY DISABLE PROCEDURE

Disable Procedure

In the Windows NT environment, a log-on box is displayed requesting a user name and password each time Windows® NT starts up. The Windows NT log-on box may be disabled if the NRT software login function is sufficient for security or if the NRT software is to start automatically once Windows NT is running. Once the NRT software starts, the user must still choose Login under the File menu and enter a user name and password to gain access to the NRT. *Note: The Login function in the NRT software can not be eliminated.* To eliminate the Windows NT log-on box, execute the following steps:

1. From Program Manger, go to the File menu (for Windows NT® Version 4.0 users, select Start, then Run). Select Run and type regedit32. This brings up the Windows NT Registry.
2. Go to the HKEY_LOCAL_MACHINE dialog box.
3. Double click on SOFTWARE, then on MICROSOFT.
4. Double click on WINDOWS NT, followed by CURRENT VERSION, and then WINLOGON. At this point the screen will be split into two sections. The section on the left side contains the tree structure of the registry and the right side contains values stored in the registry.
5. From the Edit menu, select Add Value. A dialog box will pop up. Under Value Name, type DefaultPassword (do not change the displayed data type).
6. Press OK. Another dialog box will pop up. Under String, enter the current password of the NT administrator. The password is case sensitive, so be sure it is entered correctly. Press OK for the change to take effect.
7. From the Edit menu, select Add Value again. Under Value Name, type AutoAdminLogon. Press OK. Under String, enter 1 (do not change the displayed data type).
8. Verify that the two new variables entered in the previous steps appear on the right side of the screen. The variables should appear as follows:

   AutoAdminLogon:REG_SZ:1
   DefaultPassword:REG_SZ:<password> (Password is the password entered by the administrator in Step 6.)

9. Exit the Windows NT Registry, and reboot Windows NT. When Windows NT starts, the log-on screen should be bypassed.

Re-Enable Procedure

To re-enable Windows NT security, follow steps 1-3 above. Tab over to the right section of the screen and click on the AutoAdminLogon variable. From the Edit menu, select Delete. Press OK. Do the same for the DefaultPassword variable. Exit the Registry, and reboot Windows NT.
APPENDIX B

WINDOWS NT® 4.0 INSTALLATION

(For current Windows 3.1 or Windows 3.51 users)

Windows NT® is a Registered trademark of the Microsoft Corporation

NOTES

• This installation instruction was performed with a Windows NT® 4.0 CD-ROM software and the MicroSolutions Backpack external CD-ROM drive. While the installation is similar there may be minor differences due to your choice of CD-ROM drive.

• For upgrades from Windows 3.1, you must purchase the full version of Windows NT® 4.0. An Upgrade Version will not work.

CAUTION

Backup the entire contents of the hard drive prior to beginning this installation.

Preparing for Installation

The installation is to be done with an external CD-ROM drive. Be certain that the external CD-ROM drive has Windows 4.0 drivers.

1. Connect the external CD-ROM drive per the installation instructions provided by the manufacturer of the drive. Continue only after the drive is successfully connected.

2. Gather the Windows NT® 4.0 package, CD-ROM driver floppy, a tablet (for notes), and a blank floppy (Emergency Repair Disk created later).

Beginning the Installation

1. With the PC power off, insert the first floppy disk of the NT 4.0 set.

2. Insert Disk 2 when instructed and follow the screen prompts. Pick the default selections, if any, through this portion of the installation.

3. Insert Disk 3 when instructed. At this point the NT 4.0 system is analyzing your hardware to determine what drivers to install. One of the screen prompts will identify any mass storage devices that it discovers.

4. Press S to install the external CD-ROM software driver. Select Other then press ENTER.

5. Now the screen asks for the Manufactures floppy. Install the CD-ROM driver diskette into the floppy. Press ENTER.

6. The screen will now identify the appropriate driver for the CD-ROM drive.

WARNING

If the driver supplied with the CD-ROM is invalid, the display will show the previous screen again. When this occurs you need to contact the manufacturer of the CD-ROM for assistance. You will not be able to continue with this installation.

7. Press ENTER to select the discovered driver. Follow the screen prompts. Pick the default selections, if any, through this portion of the installation.

NOTE

NT will display the hardware that was discovered. Make any changes, if necessary, to correct the hardware listed. NT will ask for the CD-ROM driver again. Then the NT system will RESTART.
Continuing the NT 4.0 Installation

At this point the rest of the installation will be in the Windows environment. Use the check boxes below to follow through the rest of the process.

- **Setup Options:** Select the default, Typical.
- **Name and Organization:** (example Name: "Security", Organization: "Acme Tools") Enter the appropriate items for your installation.
- **Registration:** Enter the CD Key found with the Windows NT® 4.0 Software.
- **Computer Name:** Enter the name for the PC. (some examples: Dell75, NRT-PC, Pent90, AcmePC)
- **Administration Account:** Here the default Administrator account is now requesting a password for the Administrator Account. Enter the password of your choice. The password is case sensitive. You may select no password by leaving the password block blank. This is not recommended.
- **Emergency Repair Disk:** Create one YES or NO. (the default is Yes). This is where you need the blank floppy.
- **Windows NT Components:** Select the default, Install the most common components.
- **Computer Network Connections:** Do not select the default. Select Do Not connect this computer to a network.
- **Finishing Setup:** Now the NT Operating System is completed the configuration of your PC. Press FINISH.
- **Display Tests:** Now you are asked to configure the display to the appropriate resolution.
- **Load Drivers:** No user intervention is required here.
- **Restart Computer:** The PC now reboots to complete the changes.

Initial Log on to NT 4.0

1. Press CTRL-ALT-DEL when screen display prompts for it in order to log onto the Windows NT system.
2. Enter the password for the Administrator account in order to log on.
WARRANTY PAGE
1.7.1 Connecting the MON-20T Option

The MON-20T monitor with touchscreen option has an extra connection required to make the touchscreen operable. Connect the nine-pin connector from the touchscreen adaptor unit at the rear of the monitor to the COM-1 port on the rear of the NRT-586T. Secure the connection with the two screws provided with the cable. The following steps must be completed prior to connecting a monitor with the VID-NET option:

1. Attach the end of the video loopback cable with two RCA-type connectors to the VGA input connector marked "VGA IN" on the VID-NET board (refer to Figure 1.7.1-1).
2. Attach the other end of the loopback cable to the VGA output connector on the back of the NRT-586T.
3. Attach the monitor VGA cable (MON-17/20/20T) to the connector marked "MONITOR OUT" on the VID-NET board.
4. Connect a transient voltage suppressor (VID-TVS) supplied with the VID-NET option to each of the RCA connectors on the loopback cable.
5. Each of the RCA connectors has a label marked "VIDEO 0" or "VIDEO 1" near the connector. Connect the end of the VID-TVS on the "VIDEO 0" connector to the primary video source. If there is a secondary video source, connect it to the VID-TVS on the "VIDEO 1" connector.

![Diagram of VID-NET connection](image)

Figure 1.7.1-1 Connecting a monitor with VID-NET option

Note: For more information on using the VID-NET option, refer to the VID-NET Manual.
1.7.3 Connecting a Monitor with the VID-NET and LP-1 Options

The following steps must be completed prior to connecting a monitor with the VID-NET and LP-1 options:

1. Attach the end of the video loopback cable with the two RCA-type connectors to the VGA input connector marked "VGA IN" on the VID-NET board (refer to Figure 1.7.3-1).
2. Attach the other end of the loopback cable to the VGA output connector on the back of the NRT-586T.
3. Connect a transient voltage suppressor (VID-TVS) supplied with the VID-NET option to each of the RCA connectors on the loopback cable.
4. Each of the RCA connectors has a label marked "VIDEO 0" or "VIDEO 1" near the connector. Connect the end of the VID-TVS on the "VIDEO 0" connector to the primary video source. If there is a secondary video source, connect it to the VID-TVS on the "VIDEO 1" connector.
5. Connect the video tap to the connector marked "MONITOR OUT" on the VID-NET board.
6. Connect the monitor SVGA cable (MON-17/20/20T) to the video tap.
7. Attach the SYNC cable on the video tap to the SYNC input on the LP-1 board.
8. Connect the light pen cable to the PEN input on the LP-1 board.

Figure 1.7.3-1 Connecting a Monitor with the VID-NET and LP-1 Options
NOTES